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Abstract

The FAR23 Loads program was developed by Hal C. McMaster of Aero Science
Software in 1989 and was updated in 1990, 1993 and 1995. McGettrick
Structural Engineering, Inc. is the current owner of FAR23 Loads. This program
provides a procedure for calculating the loads on an airplane according to CFR
14 FAR Part 23. The original version of the FAR23 Loads Program was written in
Q-Basic. This new version of the program (FAR23 Loads Professional Version
2003) was developed at Wichita State University. It uses Visual Basic 6.0 and
can be executed on the Windows Operating System version 95 or higher. This
version is a single user-friendly integrated program that combines the original 20
individual modules.
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Executive Summary

The FAR23 Loads program was developed by Hal C. McMaster of Aero Science
Software in 1989 and was updated in 1990, 1993 and 1995. McGettrick
Structural Engineering, Inc. is the current owner of FAR23 Loads. This program
provides a procedure for calculating the loads on an airplane according to the
Code of Federal Regulations, Title 14 — Aeronautics and Space, Chapter | —
Federal Aviation Administration, Subchapter C — Aircraft, Part 23 — Airworthiness
Standards: Normal, Utility, Acrobatic and Commuter Category Airplanes, Subpart
C — Structures. This is referred to as CFR 14 FAR Part 23. Most of the detailed
flight loads are developed from the flight envelopes specified in CFR 14 sections
23.333 and 23.345. At every point specified in the flight envelope, the airplane is
balanced by a tail load reacting to the specified linear normal acceleration and
the aerodynamic lift, drag, and moment about the center of gravity. The data
needed to make these balancing calculations consists of weight and center of
gravity, aerodynamic surface geometry, structural speeds, and aerodynamic
coefficients. Modules in the FAR23 Loads program develop these data. After
these balancing loads data are developed, the critical structural loads are
determined for each component. For the critical conditions, the air loads, inertia
loads, and net loads are calculated. Aileron, flap, tab, engine mount, landing, and
one engine out loads are also calculated. The landing loads are calculated from
the landing gear geometry, landing load factor, weight, and center of gravity data.

The original version of the FAR23 Loads Program was written in Q-Basic. The
program could be executed on MS DOS Operating System version 3.1 or higher.
The program consisted of 20 different independent modules. When the program
starts, the main menu appears. After selecting a module from the main menu, the
input window for that module appears and parameters for the analysis are
specified. The graphics programs FARPLOT and GEOMPLOT are stand-alone
programs for plotting data and drawing airplane geometries. These programs
read the output data from the FAR23 Loads programs and graph it using a
variety of options. Users can customize the graphs for use in reports. For certain
modules of the program, there is more than one input form, but there is no
indication as to which form the user is currently on or what data have already
been entered. If the analysis is done before entering all of the data, the user may
get error messages and/or incorrect outputs.

Professional Version 2003 of the FAR23 Loads program was developed at
Wichita State University using Visual Basic 6.0. This version can be executed on
Windows Operating System version 95 or higher. It is a single integrated
program that combines the 20 individual modules. The new program eliminates
redundant data entry by making the data transfer process automatic, thus
eliminating errors due to the reentry of data. Data is transferred from one module
to another by the click of a button. The program also facilitates saving,
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Executive Summary

previewing and printing of all the inputs simultaneously. Although integrated,
each module can be run independently by entering all required data into that
module. This occurs without affecting the other modules. Professional Version
2003 of the FAR23 Loads program is a complete program that does not permit
the user to run a module unless valid data for that particular module have been
entered. A tool tip text provides information for each field that makes it
convenient for the user to input valid data. Saving, previewing and printing output
data for individual modules is also possible. The program provides additional
utilities like a calculator, an interpolation module and a unit conversion facility.
Help on how to use a particular module is also made available for the user to
view and print. The overall user-friendliness and ease of use of the program have
greatly improved over the original version.




1 Introduction
1.1 About FAR23 Loads

The FAR23 Loads program was developed by Aero Science Software to
calculate the loads on an airplane using methods that are acceptable to the FAA.
This new version of program developed at Wichita State University is an
integrated package that uses consolidated data for the complete aircraft and
performs calculations for all 20 modules independently.

Most of the detailed flight loads are developed from the flight envelopes specified
in the federal requirements FARs 23.333 and 23.345. At every point specified in
the flight envelope, the airplane is balanced by a tail load reacting to the specified
linear normal acceleration and the aerodynamic lift, drag, and moment about the
center of gravity. The data needed to make these balancing calculations consist
of (1) weight and center of gravity, (2) aerodynamic surface geometry, (3)
structural speeds, and (4) aerodynamic coefficients. These data are developed
by modules in the FAR23 Loads program.

After the data needed to calculate the balancing loads are developed, the critical
structural loads are determined for each component. For critical conditions, the
air loads, inertia loads, and net loads are calculated. Aileron, flap, tab, engine
mount, landing, and one engine out loads are also calculated.

Landing loads are calculated using landing gear geometry, landing load factor,
weight, and center of gravity modules.

1.2 Federal Regulations

The program FAR23 Loads provides a procedure for calculating the loads on an
airplane according to the Code of Federal Regulations, Title 14 — Aeronautics
and Space, Chapter | — Federal Aviation Administration, Subchapter C — Aircraft,
Part 23 — Airworthiness Standards: Normal, Utility, Acrobatic, and Commuter
Category Airplanes, Subpart C — Structures. This is referred to as FAR Part23.
The regulations through Amendment 42 have been included in the FAR23 Loads
program.
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1.3 Using this Report

This report is a guide to run the FAR23 Loads program and is intended to be a
supplement to reference 1. Reference 1 provides the theoretical development of
the equations used in the computer program.

Section 2 of this report describes how to install the program and run FAR23
Loads. The section also includes general information on the integrated module
and its menu structure.

Sections 3 through 22 are each devoted to a separate module of the FAR23
Loads program and are organized according to the order that the modules
appear in the main program menu. Each section has up to 3 subsections —
description, running the module and output.

Table 1.1 is a summary of the modules in FAR23 Loads.

Table 1.1 Summary of Modules in the FAR23 Loads Program

Module Name Section Description
Weight Estimation 3 Estimates weight of airplane and its components
Weight and CG 4 Calculates Weight, center of gravity, and inertia
Envelope of Loads 5 Envelope of discretionary loading
Aerodynamic Surface 6 Calculates geometric properties of 16 aerodynamic
Geometry surfaces
Structural Speed 7 Determines structural design speeds
Mach Limitations 8 Determines Mach limitations
Aero Coefficients 9 Calculates aerodynamic coefficients
Air Loads 10 Calculates wing air loads
Flight Loads 11 Calculates loads within the flight envelope
Select 12 Calculates the critical flight loads
Aileron Loads 13 Calculates loads on aileron
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Flap Loads 14 Calculates loads on flaps

Wing Inertia 15 CaICL.JI.ates spanwise inertia loads for critical wing
conditions

Net Loads 16 Calculates the net wing loads

Engine Mount Loads 17 Calculates engine mount loads

Landing Loads 18 Calculates landing loads

Landing Load Factor 19 Calculates landing load factor

T:_a|l IToa(_js 20 Calculates the chordwise distribution for tail loads

Distribution

Tab Loads 21 Calculates tab loads

One Engine Out 22 Calculates loads with one engine out

Loads




2  Getting Started System Requirements
2.1 Systems Requirements

The FAR23 Loads program is designed to run on a personal computer. The
minimum system requirements are as follows:

e A Windows compatible personal computer
e MS-Windows 95 or higher
e A 44X (or better) CD-drive

2.2 FAR23 Loads Disk

The FAR23 Loads program is contained on one Compact Disk.

2.3 Installing the FAR23 Loads Program

The FAR23 Loads program must be installed using the following steps:

e Insertthe CD into CD drive.
e From Windows Explorer, select the CD drive.
e Double click on the Setup.Exe file.

e Follow the on screen instructions to continue the installation.

2.4 Running the FAR23 Loads Program

To run the FAR23 Loads program, double click on the file with the name
FAR23LOADS. When the program starts, a flash screen followed by the main
window shown in figure 2.1 appears. The main menu window has 3 visible menu
options and 1 invisible menu option. Details of visible menu options are as
follows:

e File: Figure 2.2 shows the main menu window with File menu active. The
File menu has 8 sub menus.

o New — Creates a new file.
o Open — Opens a previously saved file.
o Save All Input — Saves inputs of all modules.
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o Save All Input As — Saves existing active file with a different file name.

o Preview All Input — Enables user to preview all inputs. Input data for
modules where data has not been entered will either appear blank or
as a zero. When this menu option is selected, the fourth invisible menu
“Input” becomes visible as shown in figure 2.12. Error Messages might
pop up if modules are empty. Details of the input menu are given at the
end of visible menu options.

o Plot Geometry — The Plot Geometry menu gets activated only after the
file has been saved. It also becomes active if a previously saved file is
opened. Messages pop up confirming the entry of data in relevant
modules. If the user has not entered data in relevant modules,
messages requesting entry of data in required modules appear. The
Plot Geometry menu has 3 sub menus as shown in figure 2.3:

1. Plot Wing Assembly — Plots the wing assembly. The wing geometry
plot automatically includes the aileron geometry, aileron aft geometry,
aileron forward geometry and flap geometry.

2. Plot Horizontal Tail Assembly — Plots the horizontal tail assembly.
The horizontal tail geometry plot automatically includes the elevator
geometry, elevator tab geometry, elevator aft geometry, elevator
forward geometry and horizontal stabilizer geometry.

3. Plot Vertical Tail Assembly — Plots the vertical tail assembly. The
vertical tail geometry plot automatically includes the rudder
geometry, rudder aft geometry, rudder forward geometry and
vertical stabilizer geometry.

o Close File — Enables the user to close an existing file. This menu will
close the file but not terminate the program. The user can open
another file or create a new file without exiting the program.

o Exit FAR23 Loads — Ends the FAR23 Loads program.

o Return to Main Menu — Enables user to close existing menu and return
to the main menu from which other modules can be selected and
executed. Note that this option is valid only for the individual modules
that are described in Sections 3 through 22.

Output: The Output menu is used to preview, save and print output and
also to update input / output data to other modules. The Output menu has
5 sub menus. Details are as follows:

o Preview Output — Enables user to preview output in the same window.
Other options are enabled only after the preview output option is
selected.

o Print Output — Enables user to print output on paper. Errors might pop
up if the printer is not installed or connected.
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O

Save Output as Notepad — Saves output data to notepad file (*.txt)
format.

Update Output To Other Modules — Updates output to respective
modules. Refer to table 2.1 for details on data flow between modules.
After the data is updated, a message box displaying the names of
modules to which data has been updated appears.

Close Output — Enables user to close the output menu and return to
the main window. If the user has not updated data to other modules
using the ‘Update Data To Other Modules’, selecting the ‘Close Output’
option results in a user prompt to determine whether the data needs to
be updated to other modules.

Utilities: Figure 2.4 shows the main menu window with Ultilities menu
active. The Utilities menu has 3 sub menus.

O

(@)

Calculator — Opens the calculator

Interpolation — Opens the interpolation window. This window helps the
user interpolate a set of values. Figure 2.5 shows the interpolation
window at startup. The window has three sections — Data Available,
Data Required and Controls. In the Data Available section, X1 and X2
are the values for which corresponding data V1 and V2 are available.
In the Data Required section, XR is the value for which an interpolated
value is required. In the Controls section, Interpolate button
interpolates the required value based on the available data, Reset
button clears the window for fresh data entry and Close button closes
the interpolation window.

An example of using the Interpolation window is given below.
Let, X1=10; X2=20; V1=100; V2=200 and XR=15.

Here, interpolated value for XR=15 is required. After entering all the
data, when interpolation button is hit, the window appears as shown in
figure 2.6. The interpolated value appears in the textbox with a yellow
background. If any input box is left empty, the program gives a
message to enter the corresponding value. An illustrative message that
appears when the user leaves the XR box empty is shown in figure
2.7.

Unit Conversion — Enables conversion of units from one system to
another. The ‘Uconeer’ application has been downloaded from the
internet and is being used in this program since it is available for free
to all users. Details on how to use the ‘Uconeer application are
available in its help files. Figure 2.8 shows the ‘Uconeer’ window.

Help: Figure 2.9 shows the main menu window with Help menu active.
The Help menu has 2 sub menus.

O

User Manual — Opens this report in .pdf format.
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o About — Details about the license and permission for use of the
software are mentioned. Figure 2.10 shows the About window.

e Input: Figure 2.12 shows the main menu window with the input menu
visible and active. The input menu has 3 sub menus:

o Print Input — Prints input data on paper. Errors might pop up if printer is
not installed or connected.

o Save Input as Notepad — Saves input data to notepad file (*.txt) format.

o Close Input — Closes the input menu and returns to main window with
3 visible menus.

FAR23 LOADS - MAIN MENU

File Utilities Help

Figure 2.1 FAR23 LOADS Main Menu Window

FARZ23 LOADS - MAIN MENU
&[0 Lilities Help
Chrl-+1

Jpen... Chel4+0

Exit FARZS Loads kel
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Figure 2.2 FAR23 LOADS Main Menu Window (File Menu Active)

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
FIEN Utiities  Help

RATED PROGRAM: SELECT A MODULE TO RUN

Save all Input. .. Ckrl+5 _
Save Al Tnput As... Chl+a Wwieight & CG Envelope of Loads Geometny
Preview Al Input Ckrl+P | )
Plok Geomekry Plok %ing Assembly Aero Coefficients
Zlose File Chel+C Plat Horizonkal Tail Assermbly
Exit FARZ3 Loads kel Plok Yertical Tail Assembly Loads Flap Loads
| | L :
Wing Inertia Met Loads Engine Mount Loads Landing Loads
Landing Load Factar Tail Load Distribution Tab Loads 1 Engine Qut Loads

Figure 2.3 FAR23 LOADS Main Menu Window (Plot Geometry Menu Active)

FARZ23 LOADS - MAIN MENU
File BANIEEN Help

Calculakor

Interpolation
Uit Conversion

Figure 2.4 FAR23 LOADS Main Menu Window (Utilities Menu Active)
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INTERPOLATION

Data Available Controls
#1 |l % |7 Interpalate
we [ wz |

Bezet
D ata Required
=R | Cloze

Figure 2.5 Utilities Menu (Interpolation Window]

INTERPOLATION

Drata Available Controls
®1 10 Y1 100 . interpalate
we [0 w2 fan
Bezet
Data Required
R Iwi ¥R Ii Cloze

Figure 2.6 Interpolation Window after Interpolate button is hit

ERROR MESSAGE X
@ Enter Mumerical walue of ¥R,

Figure 2.7 Error Message when XR box is left empty
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L] Uconeer - Units Conversion for Engineers [Z”§|E|

Project Risk Analysis {" R =
Know how accurate your capital cost
estimate really is and how much contingency y @
yvou need to prevent any cost over run. A
Fram : | |meter’- ﬂ | Clear ‘
To: | 0000247105 [acre ~| Com#t | Copynu |
Recently Used Categones
. From| Available Unitzs | To
Area
Denzity + 5 pecific Yalume | meter - Swap From / Ta Urits |
Energy + Woark - acre o
E nthalpy i are i
Farce _ - centimeter - Fezult Format
Heat Capacity N -~ fook -~
Heat Transfer Coefficient ~ hectare ~ ‘o EulEris
Length r~ inch o~ . .
b ass A II?IC " ~ " Fined Decimalz
Masz= Flow Rate llomete F ;
Prossre ~ il ~ FI:-:TEd '.:\'-Ith Separators
Temperature _ = | milimetes ' " Sciegntific
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Significant Digitz |6

Clipboard Contents ; |Figure 25 |nterpolation \Window after [nterpolate but

Figure 2.8 Unit Conversion Application ‘Uconeer’

FARZ3 LOADS - MAIN MENU
File  Utilities

Figure 2.9 FAR23 LOADS Main Menu Window (Help Menu Active)
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About FAR 23 Loads

This Product has been licensed to: Fedral Aviation Administration

FAR 23 LOADS

Professional Yersion 2003

Coypright @ 2003 McGettrick Structural Engineering. Inc.

The FAR23 loads program provides a procedure for calculating the lnads on an airplane
according to the Code of Federal Regulations, Title 14 - Aeronautics and Space.
Chapter | - Federal Aviation Administration, Subchapter C - Aircraft, Part 23 -
Ainworthineszs Standards: Mormal, Ubility, Acrobatic and Commuter Category Airplanes,
Subpart C - Structures.

i arning:

This cormputer program iz protected by copyright lavw and international treaties. Mo part of thiz work may be
reproduced or transmitted in any forma or by any means, electronic or mechanical, including phatocopying
and recording, or by any information storage or retrieval system, except as may be expressly permitted by
the 1976 Copyright Act or in writing from MeGettick Structural Engineernng, Inc.

Jrnauthiorized reproduction or distibution of this program, or any portion of it, may result in severe civil and
chminal penaltiez. and will be progecuted to the marimum extent possible under the law.

Suztem Info...

Figure 2.10 About Window

When the user selects New from the File menu, a window with all modules
appears. Figure 2.11 shows the FAR23 Loads main menu with all modules.
When Open is selected, the user is asked to select a file from the ‘Open’
dialogbox. A window as shown in figure 2.11 appears after an appropriate file is
selected. If the file is not for the FAR23 Loads program, an error message will be
given.
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FARZ3 LOADS - MAIN MENU

File Utiities Help

Weight E stimation

Weight & CG

Envelop of Loads

FAR 23 LOADS INTEGRATED PROGRAM: SELECT A MODULE TO RUN

Geometry

Structural Speed

Fach Limitations

Air Loads

Aero Coefficients

Flight Loads

Select

Alleron Loads

Flap Loads

Wfing Inertia

Met Loads

Engine Mount Loads

Landing Loads

Landing Load Factar

Tail Load Distribution

Tab Loads

1 Engine Qut Loads

Figure 2.11 FAR23 Loads Main Menu (Module Names)

FARZ3 LOADS - MAIN MENU

gl Lkilities  Help

3

Save Input As Motepad. ..

E3T]  Close Input

M CONTINUOOUS HP
NUMEEER. OF ENGINES
NUMEEE. OF 3EATS

HOTR3 AT CRUISE FPOWER
My BAGGAGE WEIGHT
TNFRE33TRIZED

o o o o O

ENGINE MOUNT LOADS

4 ¥

Figure 2.12 FAR23 LOADS Main Menu Window (Input Menu Active)

The modules shown in figure 2.11 are interconnected to each other. There are
some modules which share common input data. For some modules the output
data goes as input to another module. For a few cases both the input and the
output data go to different modules. Table 2.1 shows the data that flows from one
module to another in the FAR23 loads program.
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Table 2.1 Data flow in the FAR23 Loads Program

From Module

To Module

Weight & CG

Envelope of Load

Data Transferred
Weight
X Coordinate
Y Coordinate

Z Coordinate

Weight Estimation

Engine Mount Loads

Max. Engine HP

Landing Load Factor

Landing Loads

Landing Weight

Structural Speed

Landing Loads

Takeoff Weight

Mach Limitations

Mc
Mo

Shoulder Altitude

Select Critical Loads

Takeoff Weight

Pos. N

Flight Loads

Takeoff Weight
Airplane Category
Va
Ve
Vp
\

Mo

Mc

Tab Loads

Ve

Flap Loads

Takeoff Weight

V(Stall Clean)
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V(Stall Flaps)

Ve

Aileron Loads

Va
Ve

Vo

Wing Geometry

Landing Load Factor

Sw

Structural Speed

Sw

Aerodynamic

Leading Edge Points

Trailing Edge Points

Coefficients
DY
2*Sy (Ft?)
Select Critical Loads MAC (Ft)
ARy
2*Sy (Ft?)
Flight Loads MACy (Ft)
XLEw + MACy * 0.25
2*Sy (Ft?)
Flap Loads
MACe MACw
Leading Edge Points
Wing Inertia

Trailing Edge Points

Aileron Fwd Geometry

Aileron Loads

Sacwo) (Ft)

Aileron Aft Geometry

Aileron Loads

SanFT) (th)

Sk (FtY)
Flap Geometry Flap Loads
MAC{ MACw
Vertical Tail Geometry | Select Critical Loads Svr (Ft?)
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MACyt
XLEyr + MACyr * 0.25

ARvr

Tail Load Distribution

Svr (Ft)

1 Engine Out Loads

Svr (In?)
ARyt
XLEyt + MACyt * 0.25

XLEyt + MACyt * 0.50

Tail Load Distribution Sk (In?)

Rudder Geometry Select Critical Loads Sk (Ft?)

1 Engine Out Loads Sk (In?)
Tail Load Distribution Srarm) (Ft)

Rudder Aft Geometry
Select Critical Loads Srarm) (Ft)
. . . . 2
Rudder Fwd Tail Load Distribution Srrwp) (F1°)
Geometry

Select Critical Loads

SrFwD) (th)

Horizontal Tail

Select Critical Loads

2*Sur (FtY)
ARyt
XLEwr + MACyr * 0.50

XLEnt + MACy1 * 0.25

Geometry Se/Sir
XLEur + MACyr * 0.05
Flight Loads
XLEnt + MACHr * 0.25
Tail Load Distribution Sur (In?)
Elevator Geometry Select Critical Loads Se (Ft%)
Elevator Fwd Tail Load Distribution SeEwo) (In?)
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Geometry

Select Critical Loads

SeFwb) (th)

Elevator Aft Geometry

Tail Load Distribution

SenrT) (|n2)

Select Critical Loads

SEnFT) (th)

Elevator Tab

Geometry Tab Loads Se(rag) (In?)
Aero Coefficients Air Loads Cruise, Landing & Enroute
Data
Flight Loads Select Critical Loads V-n Data File
Air Loads Net Loads Air Loads File
Wing Inertia Net Loads Wing Inertia File
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3

Weight Estimation

3.1 Weight Estimation Description

There are three weight estimation modules in the FAR23 Loads program. The
first module ‘Weight Estimation’ estimates the weight of the airplane and its major
components. The other two modules, ‘Weight & CG’ and ‘Envelope of Loads’, are
discussed in sections 4 and 5 respectively.

To estimate the weight of the airplane and its components, the following
information is required:

Number of engines
Total horse power
Type of engine

o 4-cycle reciprocal
o 2-cycle reciprocal
o turbocharged

o turboprop

o liquid-cooled
Hours of endurance at cruise speed
Number of seats
Total baggage weight

Whether the cabin is pressurized or not

Based on this information, the weight of different components and the total
aircraft weight are calculated.

3.2 Running the Weight Estimation Module

To run ‘Weight Estimation’, click the module from the main window. The main
input window appears as shown in figure 3.1.
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C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ltilities  Help
Wweight E stimation

Mame and model of your airplane: & Place Single Engine General Aviation Airplane |

How mary engines:
Tatal mazimum HP of engines:
How many seats:

Total baggage weight [Lbz]

1l

Haours of wour airplane to fy on full tanks at cruise power |3

MO |

Type of engine |4 CYCLE RECIPROCAL |

|z airplane preszurnzed

Figure 3.1 Weight Estimation Input Window

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e Help: The Help menu has only one option. It provides help on how to use
the weight estimation module.

3.3 Weight Estimation Output

The output from the ‘Weight Estimation’ module consists of the maximum take-off
weight and weights of the major components of the airplane. The components
are grouped into structure, powerplant and systems.

The results of this module are used in the ‘Weight & CG’ and ‘Envelope of Loads’
modules to determine the envelope of useful loadings and to calculate weight,
center of gravity and inertia of the airplane.

18



4 Weight & CG
4.1 Weight & CG Description

Weight & CG calculates the weight, center of gravity and inertia of the airplane
for any specific loading configuration. These calculations are done at the four CG
locations defining the weight structural limits diagram. These CG locations are
the aft gross weight, the forward gross weight, the most forward reduced weight
and the minimum weight. On an airplane with retractable landing gear, it is
usually necessary to account for the shift in CG due to retraction of the gear with
a second set of four loading conditions.

The weight limits are defined in FAR 23.25. The maximum weight must not be
less than the empty weight plus 170 pounds for each seat for normal and
commuter categories (or 190 pounds for utility and acrobatic category airplanes)
plus oil at full capacity and a half hour of fuel at maximum continuous power.
Also, the maximum weight must not be less than the empty weight plus minimum
crew and full tank capacities of fuel and oil.

The minimum weight is not more than the empty weight (including unusable fuel,
full oil, and fluids) plus the minimum crew (usually the pilot) and a half hour of
fuel at maximum continuous power. For turbojet powered airplanes, the required
fuel is 5 percent of the total fuel capacity.

The location of the weight components can be established from the three-view
drawing or inboard profile drawing. The weight can be obtained from the
component manufacturer, from actual weighing of the part, by calculation from
drawing dimensions and material density, or from the ‘Weight Estimation’
module.

The inputs required are the coordinates, weight and moment of inertia for each of
the components of the airplane, and useful loads for the condition. The inertia of
small components may be neglected with no appreciable effect on the total
inertia of the airplane.

The component data is entered in the weight database. This is the same
database used by the ‘Envelope of Loads’ module.

The weight database contains the component weight data and the location
dimensions. The default value for the maximum number of components in the
database is 100, although the user may change this value. The database is
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divided into 3 sections: empty weight items, minimum weight items and
discretionary items. Fifty percent of the items are considered empty weight items,
ten percent are minimum weight items and forty percent are discretionary items.
The type of item is indicated by the item number. Using the default value of 100
items results in the following: items 1 through 50 are empty weight items, items
51 through 60 are minimum weight items and items 61 through 100 are
discretionary items. When entering data into the database, it must be entered at
the proper item number.

4.2 Running the Weight & CG Module

To run ‘Weight & CG’ module, click the module from the main window. The main
input window appears as shown in figure 4.1.

C:iFar23Loadsi6 Place Single Engine General Aviation Aircraft. Far

File Qutput  Ltilities  Help
Wwieight, Center of Gravity and Maoment of [nertia

Wikiat iz the maxirnum number of weight itemns wou will include in wour weight databaze?
Mumber of empty weight items

Mumber of minimum weight items

=

Iterm Mo Component Description Wwieight [Lb)
| | [wing Outhoard | 330 |
* [Inch] Y [Inch] Z lInch] I [Lbrin" 2] Iy [Lbrin"2] Iz [Lbvin"2]
|97.87 | o | [57.73 | [4444110 | [133485 | [4444110 | =l

Figure 4.1 Weight & CG Input Window

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. When the number of weight items to be considered
in the database is left empty, the default value of 100 is selected. The number of
empty and minimum weight items is calculated based on the total items and
displayed in the respective text boxes with a yellow background. The user does
not have the flexibility to change these calculated values. Iltem numbers appear
in the text box in grey color. Use the scrollbar to navigate through the item
numbers. It is recommended to use the top and bottom arrows of the scrollbar
rather than directly using the scroll tab to navigate through the item numbers
since errors can occur due to scrolling with the tab.
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The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e Help: The Help menu has only one option. It provides help on how to use
the weight and CG module.

4.3 Weight & CG Output

The Weight & CG output includes the weight, center of gravity, the inertias with
respect to airplane coordinates, the inertias with respect to principle axes and the
angle 0 for a single load configuration. Inertias are given in both sludg-ft> and Ibs-
in®. The airplane weight and center of gravity are needed for the calculation of
balanced flight and landing conditions in modules ‘Flight Loads’ and ‘Landing
Loads’. The airplane inertia is needed for the calculation of maneuver and gust
flight conditions and unbalanced landing conditions in modules ‘Select’ and ‘1
Engine Out Loads’.
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5 Envelope of Loading Conditions
5.1 Weight Envelope Description

This module calculates the envelope of discretionary useful loading. It uses the
same database as the ‘Weight & CG’ module. The database contains the
component weight data and location dimensions. This weight data comes from
the ‘Weight Estimation’ module or actual known weights; the location dimensions
come from the three-view drawing.

This module directly receives data from the ‘Weight & CG’ module when the
‘Update Data To Other Modules’ menu option is selected from the ‘Output’ menu
in ‘Weight & CG’ module. Although data is received automatically, this module is
flexible enough to create or modify the database or add, delete, edit or move the
component data. The minimum flight weight is calculated and the envelope
enclosing all possible loadings is calculated. From the envelope plot of useful
loadings, the four structural limit points can be selected to include the most
desirable and practical loadings. See section 4 for additional information on the
weight database.

5.2 Running the Weight Envelope Module

To run the ‘Envelope of Loads’ module, click the module from the main window.
The main input window appears as shown in figure 5.1. The values in textboxes
with yellow background are updated automatically from respective modules.

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ltilities  Help

Envelope of Loading Condition

what is the mazimumn number of weight ikerns pou will include in your weight database?
Mumber of empty weight items

Mumber of minimum weight items

[term Mo Compotent Description Weight (Lb] i‘
| | [wing Outhoard | (330 |
# [Inch] Y [Inch] £ [Inch]
|97.67 | o | [87.73 |
hd

Figure 5.1 Envelope of Loads Input Window
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5 Envelope of Loading Conditions

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e Help: The Help menu has only one option. It provides help on how to use
the weight & CG module.

5.3 Weight Envelope Output

The output from this module is the envelope of useful loads and includes the
weight and CG of the airplane for given loading conditions. This data is used in
the ‘Flight Loads’ module.
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6 Aerodynamic Surface Geometry
6.1 Surface Geometry Description

The geometric properties for all aerodynamic surfaces on the airplane are
calculated by the ‘Geometry’ module. The aerodynamic surfaces include the
wing, aileron, aileron aft, aileron forward, flap, rudder, rudder aft, rudder forward,
elevator, elevator aft, elevator forward, elevator tab, horizontal tail, horizontal
stabilizer, vertical tail and vertical stabilizer.

This module must be used to analyze each aerodynamic surface. For each
surface, the user enters the coordinates to define the leading and trailing edges
of the surface. The program divides the surface into elements and calculates the
area of each element.

The inputs required for this program includes the coordinates of the leading and
trailing edge of the aerodynamic surface. Two points define a straight leading or
trailing edge. Three points can be used to define the leading edge of a wing with
a leading edge extension at the inboard end of the wing. Three points can also
be used to define a straight leading edge with a raked tip. A complex or curved
leading or trailing edge can be defined by a series of points assuming that the
points are connected by short straight lines.

6.2 Running the Geometry Module

To run the ‘Geometry’ module, click the module from the main window. The main
input window appears as shown in figure 6.1. This window displays all the
aerodynamic surfaces. Select one surface at a time and enter the data required
forr that surface. Since the maijority of the input and output data from these
modules goes to other modules, it is highly recommended that the user update
the data to other modules. By doing so, errors due to reentry of redundant data
are eliminated.

When the user selects a surface for data entry, an input window as shown in
figure 6.2 appears. The inputs required are the name of the surface, whether the
surface is symmetrical about the x-axis (y=0), the number of increments to divide
the surface into, and the coordinates for the leading and trailing edge of the
surface. For coordinates, x-value is the fuselage station and y-value is the wing
station. Data should be entered starting from the lowest fuselage station since
data in the same order will be used to plot the geometry. If the entered data is not
in the proper order, absurd geometries will appear.
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6 Aerodynamic Surface Geometry

To enter the leading edge points, first enter the number of points. Move to the
area for the x and y coordinates. For the first points, enter the x-value, then the y-
value. Then use the mouse to click on the scroll bar next to the y-coordinate field.
The point number should advance to the next number. Then enter the next pair
of x-y coordinates. Continue until all data are entered. If an error occurs
corrections can be made by clicking at the top of the bar. It is highly
recommended that the scroll bar be positioned so that the first x-y coordinate pair
is visible. Data for the trailing edge are entered in the same way.

Finally, click the check-box to preview or print the element data points.

AERODYHAMIC SURFACE GEOMETEY

AERODYMAMIC SURFACE GEOMETREY: SELECT AMY SLIRFACE

Wing Adleran Ajleron At of hinge Adleron Fwd of hinge
Flap Rudder Rudder Aft of hinge Rudder Fwd af hinge
E leatar Elesator Aft of hinge Elewvator Frud of hinge Elevatar Tab

Harizontal T ail

Harizontal Stabilizer

Wertical Tail

Wertical Stabilizer

K

Figure 6.1 Aerodynamic Surface Geometry Main Window

C:iFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ukilities
YWing Geometmy

Help

Enter name of zurface to be analyzed :

I+ surface symmetrical about =0 7 “VES | [Fthe surface iz symmetrical about =0, enter data
for only one zide.
Mumber of increments af 'dy' [0 < dp < 100]
How marny points define the 3 How marny pointz defineg the 2
leading edge 7 trailing edge 7
% [In] ¥ {In) i‘ 3 {In] ¥ {In) i‘
Faint # [+ = Aft] [+7" = Outboard) Faint # [+ = fft] [+7" = Outboard]
[ 1 |45 | | 1 |14 | |

| e

[ Dovouwant to print / presvies element data 7

Figure 6.2 Wing Surface Geometry (Sub Module of Geometry Module)
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6 Aerodynamic Surface Geometry

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e Output:

o Plot Geometry — Plots the geometry on an X-Y axis. This menu gets
activated only after the ‘Preview Output’ menu is run. Geometry of the
surface is plotted and can be saved as a *.bmp file and opened and
modified or printed from ‘Paint’ or any other application that opens
graphic pictures.

e Help: The Help menu has only one option. It provides help on how to use
the geometry module.

6.3 Geometry Module Output

The ‘Geometry’ module calculates the area, aspect ratio, mean aerodynamic
cord (MAC) and the butt line and fuselage station of the leading edge of the
MAC. This output data is needed as input to the modules ‘Structural Speed’, ‘Air
Loads’, ‘Flight Loads’, ‘Select’, and ‘1 Engine Out Loads’.
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7  Structural Speed
7.1 Structural Speed Description

The structural design speeds and the maneuvering load factors are calculated by
the module ‘Structural Speed’. This module lets the user choose the airplane
certification category: normal, utility, or acrobatic. The module calculates the
minimum structural design speeds / load factors and verifies that the chosen
structural design speeds are greater than the minimum requirements. It also
checks that the margins between the speeds are greater than the requirements.
If necessary, the speeds are adjusted to meet the requirements relative to cruise
speed.

7.2 Running the Structural Speed Module

To run the ‘Structural Speed’ module, click the module from the main window.
The main input window appears as shown in figure 7.1. The values in textboxes
with yellow background are updated automatically from respective modules.

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ltilities  Help

Airplane Category Are computed stalling speeds known based on max

airplane normal force coefficient at max take-off YES -
weight 7
Take-off weight [Lbs) 3400 Computed ztaling zpeed [Knots] with flaps retracted at =%
_ T take-off weight
Tatal wing area [Sq-Ft) Computed ztalling zpeed [Knots] with flapz fully ESE
extended at max take-off weight :
Max sea level speed, WH [Knots) |177.4
"Shoulder altitude [Ft) 12000
Chogen Structural Speed [Knotz] and Maneuyer Load Factar
W WD WA, VF M POS M HEG
170 | | | | [ |

Figure 7.1 Structural Speed Main Window

The input required for this module includes the category of airplane, the take-off
weight, wing area, maximum speed at sea level, and the shoulder altitude.

The stalling speeds with flaps extended and with flaps retracted can be entered if
known, or they can be calculated by ‘Structural Speed’. For a known stalling
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7 Structural Speed

speeds, select 'YES’ and enter the values. To calculate the stalling speeds,
select ‘NO’ and enter the maximum lift coefficients as shown in figure 7.2.

C:iFar23Loadsi6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ltilities  Help

Airplane Category HORMAL - Are computed ztaling zpeeds known bazed on max

Chozen Structural Speed [Knotz] and Maneuver Load Factor

v VD VA vF N POS N NEG
o | | | | [ |

airplane normal force coefficient at max take-off IEE—L|
weight 7
T ake-off weight [Lbz) 3400 ‘Wing CL Max —
Tatal wing area [Sq-Fi] 184121 : -_
“wfing CLF bax
Max sea level speed, WH [Knats] |177.4
"Shoulder altitude (Ft) 12000

Figure 7.2 Structural Speed Main Window (Stalling Speeds Unknown)

The design speeds and load factors can be entered or calculated. Enter 1 for any
calculated value. Some of the design speeds can be entered, and the program
can calculate the remaining values.

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e Help: The Help menu has only one option. It provides help on how to use
the structural speed module.

7.3 Structural Speed Output

This module calculates the design speeds, load factors and Mach numbers (Mc,
Mp). The minimum values are calculated for V¢, Vp, Va and Vg, and for the
positive and negative load factors. If a design speed is chosen then the other
speeds are adjusted to meet the requirements. The calculated values are used in
the ‘Mach Limitations’, ‘Flight Loads’, ‘Aileron Loads’, and ‘Flap Loads’ modules.
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8 Mach Limitations
8.1 Mach Limitations Description

The ‘Mach Limitations’ module determines the Mach limitations for the flight
envelope diagram. For a constant Mach number, the equivalent air speed is
calculated at altitudes from the shoulder altitude to the maximum operating
altitude.

8.2 Running the Mach Limitations Module

To run the ‘Mach Limitations’ module, click the module from the main window.
The main input window appears as shown in figure 8.1. The values in textboxes
with yellow background are updated automatically from respective modules.

C:%Far23Loadsy6 Place Single Engine General Aviation Aircraft. Far
File ©ukput  Ukilities  Help
MACH Limitations

Enter MD 0411
Enter Shoulder Altitude [Ft) 12000

Erter Max Operation Altitude [Ft] 18000
Enter Increment of Altitude [Ft) 1000

Figure 8.1 Mach Limitations Main Window

The input for this module includes the Mach number at design cruising speed
(MC), the Mach number at design dive speed (MD), the shoulder altitude, and the
maximum operating altitude. An altitude increment is also required; this is used to
determine the altitudes of interest between the shoulder and operating altitudes.
All altitudes are entered in feet.

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:
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8 Mach Limitations

e Help: The Help menu has only one option. It provides help on how to use
the mach limitations module.

8.3 Mach Limitations Output

The output from ‘Mach Limitations’ includes the air speeds at altitudes between
the shoulder altitude and the operating altitude. This data can be plotted on the
flight limits diagram. All speeds are given in knots equivalent air speed (KEAS),
and the altitudes are given in feet.
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9 Aerodynamic Coefficients
9.1 Aerodynamic Coefficients Description

The aerodynamic coefficients module is used to calculate the aerodynamic
coefficients for cruise, landing and enroute conditions. This module calculates the
basic and additive spanwise aerodynamic lift coefficient distributions for the wing.
It combines these with the spanwise lift coefficient distribution for any specific
total wing lift coefficient and then calculates the associated spanwise drag and
moment coefficients for that wing C,.

The aerodynamic coefficients module also calculates the stall lift coefficient and
the angle of attack for the wing. The pitching moment coefficient of the fuselage
and nacelle is calculated and added to the total wing moment coefficient to
provide lift, drag and moment coefficients for the airplane-less-tail configuration
for any C.. The drag moment of the extended landing gear is calculated and
added to the airplane-less-tail. The sea level equations for lift, drag, and moment
are formulated. These equations are used to make the balancing calculations for
the V-n diagrams in the ‘Flight Loads’ module.

9.2 Running the Aerodynamic Coefficient Module

To run the ‘Aerodynamic Coefficient’ module, click the module from the main
window. The main input window appears as shown in figure 9.1. The first window
allows the selection of the cruise, landing or enroute submodules. It also provides
the flexibility to return to the main menu by clicking on the close button.
Additional data input windows for Cruise, Landing and Enroute conditions are
shown in figures 9-2, 9-3 and 9-4 respectively. The values in textboxes with
yellow background are updated automatically from respective modules.

Since this module has been customized for aero coefficients only, the user is not
asked if calculations for air loads are desired.
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9 Aerodynamic Coefficients

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far

SELECT AERODYMAMIC COEFFICIEMT COMFIGURATION

Cruize Configuration

Landing Configuration

Erroute Configuration

K

Figure 9.1 Aerodynamic Coefficients Main Window

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ltilities  Help
WwGC | a0 | BLD] sccl sco ] ALt | Tau |

Wing Geometry Calculations

Enter the configuration ; CRUISE COMFIGURATION |

How many points define the |3 How many points define the |2

leading edge Y trailing edge 7
Faoint #  * [Inches] ' [Inches] i‘ Paint #  * [Inches] ¥ [Inches] i‘
el A c— o el |

The surface iz divided into how marny surfaces of 0 ;

Figure 9.2 Aerodynamic Coefficients: Cruise Configuration Window
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9 Aerodynamic Coefficients

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ltilities  Help
WwGC | alD ] BLD] sccl sco ] ALt | Tau |

YWing Geometry Calculations

Enter the configuration :

How many points define the |3 How many points define the |2

leading edge 7 trailing edge 7
Paoint # ¥ [Inchesz] Y [Inchesz] il Paointf ¥ [Inchesz] ' [Inchesz) i‘
el I c— el |

The surface iz divided into how many surfaces of 0 :

Figure 9.3 Aerodynamic Coefficients: Landing Configuration Window

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ltilities  Help
WwGC | alD ] BLD] sccl sco ] ALt | Tau |

YWing Geometry Calculations

Enter the configuration : EMRBOUTE COMFIGLBATION |

How many points define the |3 How many points define the |2

leading edge 7 trailing edge 7
Paoint # ¥ [Inchesz] Y [Inchesz] il Paointf ¥ [Inchesz] ' [Inchesz) i‘
el I c— el |

The surface iz divided into how many surfaces of 0 :

Figure 9.4 Aerodynamic Coefficients: Enroute Configuration Window

The data input window for any case has a similar appearance and menu
structure. Each window has 7 data entry pages:

1. WGC: Wing Geometry Calculations
2. ALD: Additive Lift Distribution

3. BLD: Basic Lift Distribution

4. SCC: Stall C, Calculations
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9 Aerodynamic Coefficients

5. SCD: Spanwise Coefficient Distribution
6. ALT: Airplane Less Tail Load Calculations
7. TAU: Correction factor Tau

In the WGC page, geometry data for the wing is entered including the
coordinates for the leading and trailing edges. The window appears as shown in
figure 9.2.

In the ALD page, parameters required for the additive lift distribution calculations
are entered. The input window appears as shown in figure 9.5.

C:iFar23Loadsk6 Place Single Engine General Aviation Aircraft. Far
File ©uktput  Ukilities  Help

Additive Load Dizgtribution

How maty wing stations do you select 7 i‘

“Wwing Station #  “Wing Station [lnches] Slope CL / Deg

1 [ | 01075 | =

Figure 9.5 Aerodynamic Coefficients: Additive Lift Distribution Window

In the BLD page, parameters required for the basic lift distribution calculations
are entered. The input window appears as shown in figure 9.6.
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9 Aerodynamic Coefficients

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ltilities  Help

Bazic Load Digtribution

How many wing ztations do vou select 7

“Wwing Station #  Wing Station Angle [Degree] from i‘
[Inches] Wwiater Line

1 - I |

<

Enter Wing Station of Digzcontinuity between Flap and
Ajleron [Enter O far Mo Discontinuiby]: I:l

Figure 9.6 Aerodynamic Coefficients: Basic Lift Distribution Window

In the SCC page, parameters required for the spanwise C, calculations are
entered. The input window appears as shown in figure 9.6. The user is asked if
stall C_ is to be calculated. If the user selects YES, a window appears as shown
in figure 9.7, but if the user selects NO, a window appears as shown in figure 9.8.

C:%Far23loadsy6 Place Single Engine General Aviation Aircraft. Far
File ©ukput  Ukilities  Help
wiGC | ALD] BLD SCC|sco | ALt | Tau |
Stall CL Calculations

Do yow want to calculate stall CL 7

Hiaww many stations do pou zelect ?

Enter each zelected wing station and its first CLAAS and RN,
Itz zecond CLMA&R and BM and itz chord starting at inboard ;

CHORD ﬁ‘
WS H WS (Inches)  CILMAX RN C2LMAX A2 (Inches)
1o |[1.45 | |3000000 | (166 | (3000000 | 101 |ﬂ

Figure 9.7 Aerodynamic Coefficients: Stall C. Calculation Window when
user selects YES
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9 Aerodynamic Coefficients

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ltilities  Help
wiC | A BLD SCC|sco ] ALt Tau ]
Stall CL Calculations

Do you want to caloulate stall CL 7 MO] -

Figure 9.8 Aerodynamic Coefficients: Stall C. Calculation Window when
user selects NO

In the SCD page, parameters required for the spanwise coefficient distribution
are entered. The input window appears as shown in figure 9.9. The user is
required to input data for the spanwise drag and moment coefficients, Cp and Cy.

A value for tau, which is a correction for the slope of the lift curve, is also entered
on this page.

C:%Far23loadsy6 Place Single Engine General Aviation Aircraft. Far
File ©ukput  Ukilities  Help

Spanwize Coefficient Distribution

wihat iz TAL 7 [Fef Pery P 244)
Far what CL do pouw want wing coefficient distribution ;

Howe many wing stations do you  [7 Howe many wing stations do you [5
gelect for COO [ <=101 zelect for CM [ <=10]

WS 'S Coo i‘ WS 'S Chd i‘
[Inches) [Inches]

o el O | L o el O | CLR

Figure 9.9 Aerodynamic Coefficients: Spanwise Coefficient Distribution

In the ALT page, additional fuselage data are entered. Figure 9.10 shows the
ALT page. For the “Is landing gear extended?” prompt, landing gear information
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9 Aerodynamic Coefficients

is not required if the user selects NO; otherwise, if the user selects YES, an
additional page containing information about landing gear must be completed.
Figure 9.11 shows the landing gear page.

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ltilities  Help

Airplane Lesz T ail Load Calculations

Is landi tended ? -
el s el o el [t 5 3603 (el sl RS NO

. What is total area of horizontal +
YWhat iz length of fuzelage [Foot] 7 26.522 vertical tail [S-Ft] ? 51.785
:-'S u:ulLli\ling rook 1/4 chord [% of fuselage e Enter i CL{ (Lt
eng : niter min CL for range of CL's for 07
i curves [MINCL] : _
Enter factor to modify DCME/DCL e mreE o e N -
YWhat iz fuzelage frontal area [Sq-Ft] 7 17.21 ourves [MAKCL]: _
YWhat iz angle of fuselage center line fram wiL . .
[Mose down is negative) 0918 YWwhat iz the step you want in Cls ?

Figure 9.10 Aerodynamic Coefficients: Additional Fuselage Data

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ltilities  Help

Landing Gear Calculations

Enter frontal area of nose gear tire [Sg-Ft) : I:I Enter total frontal area of LH + RH main I:I

gear tireg [Sg-Ft]

E”ti’ fu}selage station of nose gear axle I:I Enter fuselage station of main gear axles I:I
nches) ;

[Inches) :
Enter water line of noze gear axle [Inches) : I:I Enter water line of main gear axles [Inches] I:I
Enter drag coefficient for noze gear Enter drag coefficient for main gear I:I
referenced to frontal area of tire I:I referenced to frontal area of ires ;
Enter approximate 'L of airplane CG [Inches] :I:I

Landing gear drag coefficient referenced to frontal area of tires when extended or fixed: zingle strut iz 0.29; zsingle stiut
with faired wheel cover iz 0.25; truss iz 0.54; truzs with faired wheel cover is 0,35,

Figure 9.11 Aerodynamic Coefficients: Landing Gear Data

Data entry in the TAU page is optional. This page may only be used if the user
does not have the value of tau available and desires to calculate it. The value of
tau is calculated and displayed on the same page and is also updated on the
SCD page. Figures 9.12 and 9.13 show the TAU calculation page and the
updated tau value for the SCD page.
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9 Aerodynamic Coefficients

C:iFar23Loadsk6 Place Single Engine General Aviation Aircraft. Far
File ©uktput  Ukilities  Help
wGC | aLD] BLD] sccl sco | act DTADY

Corection Factor Tau

TAL iz the corection Factor which accounts for the devation af the wing
planfarm from an ellipze in calculating the slope of the lift curve of the wing.

Enter the taper ratio of the wing

Enter the tip ratio ;

LCalculate

E I

Figure 9.12 Aerodynamic Coefficients: TAU Calculation

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ltilities  Help
wiC | ALD]| BLD] SCC) SCO ) ALT  TAU |

Correction Factar Tau

TaAl iz the corection factor which accounts for the devation of the wing
planform from an ellipze in calculating the slope of the lift curve of the wing.

Enter the taper ratio of the wing
Enter the tip ratio : D

The calculated value of TAL i |0.03734 The vaule has been updated in the SCD tab.

Figure 9.13 Aerodynamic Coefficients: TAU Updated in SCD Page

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e Help: The Help menu has only one option. It provides help on how to use
the aerodynamic coefficients module.
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9 Aerodynamic Coefficients

9.3 Aerodynamic Coefficients Output

The aerodynamic coefficients module produces the following outputs:
¢ Wing geometry calculations
e Additive lift calculations
e Basic lift calculations
e Stall calculations
e Wing aerodynamic coefficient distributions
e Airplane-less-tail aerodynamic coefficients

e Equations for aerodynamic coefficients for the airplane-less-tail
configuration

The aerodynamic coefficients for the airplane-less-tail are used in the ‘Flight
Loads’ module.
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10 Air Loads

10.1 Air Loads Description

The air loads module is used to calculate the air loads for cruise, landing and
enroute conditions. This module calculates the basic and additive spanwise
aerodynamic lift coefficient distributions for the wing. It combines these with the
spanwise lift coefficient distribution for any specific total wing lift coefficient and
then calculates the associated spanwise drag and moment coefficients for that
wing C,.

10.2 Running the Air Loads Module

To run the ‘Air Loads’ module, click the module from the main window. The main
input window appears as shown in figure 10.1. The first window allows the
selection of cruise, landing or enroute submodules. It also provides the flexibility
to return to the main menu by clicking on the close button. Data input windows
for Cruise, Landing and Enroute conditions are shown in figures 9.2, 9.3 and 9.4
respectively. The values in textboxes with yellow background are updated
automatically from the respective modules.

£l C:\Far23Loads\6 Place Single Engine General Aviation Aircraft. Far

SELECT AIRLOADS COMFIGLIREATION

Cruige Configuration

Landing Configuration

Erroute Configuration

&

Figure 10.1 Air Loads Main Window

The data input window for any case has the general appearance and menu
structure described in Section 9. Each window has 7 data entry pages:

1. WGC: Wing Geometry Calculations
2. ALD: Additive Lift Distribution
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10 Air Loads

BLD: Basic Lift Distribution

SCC: Stall CL Calculations

SCD: Spanwise Coefficient Distribution
AFS: Air Loads for Specified C_ and V
TAU: Correction factor Tau

S L

Note that page 6, the AFS page, is the only new entry that is not described in
Section 9.

In the AFS page, air loads for a specified C_ and V are entered. Figure 10.2
shows the AFS page. The first question regarding air loads for the CL entered in
the SCD tab is fixed as YES, and the user does not have option to change it.
Inputs required for this module are the case number obtained from the ‘Select’
module, a description of the condition being analyzed, the airplane speed in
KEAS, WL the wing reference plane at the plane of symmetry, and the slope of
wing reference plane.

C:iFar23Loadsk6 Place Single Engine General Aviation Aircraft. Far
File ©uktput  Ukilities  Help
wGC | 40| BLD] sccl sco AFS | Tau |
Airloads for Specified CL and W

YWwould you like ailoads [not aero coefficient diztribution] for thiz CL=1.519 inputed in VEC
Sparwize Coefficient Diztribution 7 hd

Enter caze # and description of condition to be analyzed : |22 | |F'H.-’-‘-.-'-‘-. |
Wwhhat iz pour airplane speed in KTS [EAS] 7

Enter WL wing ref plane [25% Chord] at plane of

summetry af airplane : 78.5

Enter zlope of wing ref plane [Degreesz] ;

Figure 10.2 Air Loads: Air Loads for Specified C. and V

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:
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10 Air Loads

o File:

o Save Data for NETLOADS Module - Enables user to save data in a
format that can be read by the NETLOADS module. This module is
inactive initially. After the user previews the output, this menu becomes
active and the user can save the data with a desired file name.

o Return to Air Loads Menu — Enables user to close existing menu and
return to the main window of air loads module from which other
submodules can be selected and run or the user can exit the air loads
module.

e Help: The Help menu has only one option. It provides help on how to use
the air loads module.

10.3 Air Loads Output

The air loads module produces the following outputs:
¢ Wing geometry calculations
e Additive lift calculations
e Basic lift calculations
e Stall calculations
e Wing airload distributions

e Equation for air loads

The air loads for airplane less tail are used in ‘Flight Loads’ module.
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11 Flight Loads

11.1 Flight Loads Description

The ‘Flight Loads’ module calculates the loads for any combination of airspeed
and load factor on and within the boundaries of the flight envelope. The data
necessary to make these load calculations comes from the results of modules
‘Envelope of Loads’, ‘Wing Geometry’, ‘Structural Speed’ and ‘Air Loads’.

The flight envelope should be developed for altitudes up to the maximum
operating altitude. For airplanes with a maximum operating altitude less than
20,000 feet, three altitudes are usually used: sea level, shoulder altitude, and
maximum operating altitude. If the maximum operating altitude is greater than
20,000 feet, then 20,000 feet should be included since this is where the gust
formulas begin to taper.

The flight envelope with flaps extended for takeoff, approach and landing needs
to be determined at sea level only.

11.2 Running the Flight Loads Module

To run ‘Flight Loads’, click the module from the main window. The main input
window appears as shown in figure 11.1. The values in textboxes with yellow
background are updated automatically from respective modules.

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far

File Qutput  Utilities Help
ﬁ,enexal] Speed & Alt] Enroute Info | Cruise Coef | Cruize CG | Landing Coef ] Landing CG |
General Infarmation

Enter 'wing MAC (Inch)
Enter xTC [Fus Sta appro= 5 Percent MAC H. T ail]
Enter }TF (Fus Sta 25 Percent MAC H. Tall
Enter 3w/ [Fus Sta 25 Percent MAC Wing)
Enter 2 [wfaterling 25 Percent MAL Ying|
Enter 5 [Wing Area, So-Ft)
Select Aircraft Cateqory lm
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11 Flight Loads

Figure 11.1 Flight Loads Main Window

The main window shows 7 or 9 pages depending upon the configuration. The
pages are named as follows:

1.
2.
3.

© N o o s

General: Contains general information about the airplane.
Speed & Alt: Contains information about speeds and altitudes.

Enroute Info: Contains information about enroute configuration. Based
on data entered on this page, number of data entry pages varies from
7 to 9. If enroute data has to be entered, number of data entry pages is
9 else only 7.

Cruise Coef: Contains information about cruise coefficients.
Cruise CG: Contains information about cruise CG.

Landing Coef: Contains information about landing coefficients.
Landing CG: Contains information about landing CG.

Enroute Coef: Contains information about enroute coefficients
(depends upon condition selected).

Enroute CG: Contains information about enroute CG (depends upon
condition selected).

In the first window shown in figure 11.1, general data like category of airplane,
normal, utility or acrobatic is entered. The category determines the minimum
required load factor.

In the second window, data regarding speeds and altitudes are entered. Figure
11.2 shows the Speed & Alt page.
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11 Flight Loads

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help

Speed Data Altitude Data

YPF iz speed limit for enroute configuration like partial ) ] ) )
flaps or dive breaks. [f vou have no enroute How many altitudes will you investigate™

configuraion pleasze enter WPF zame az W in nexst input
[4 would include zealevel, shoulder altitude,
20,000 ft and maximurn operating altitude).

VA 1213 YEF 1055

Y 170 MC [0323 Altitude Nurnber |:|£‘
vh [2125 MO [0.403 Altitude [Feet] D =

YE 1055 M W T 400

Figure 11.2 Flight Loads: Speed & Alt Page

On the Enroute Info page, the user is asked if there is an enroute configuration. If
not, then the question about flaps for enroute will not appear, and the user will
not see pages 8 and 9. Also, on the Speed & Alt page, if there is an enroute
condition, enter a value for VPF that is the same as VC. A brief note about this
can be seen in the Speed & Alt page shown above in figure 11.2. Figures 11.3
and 11.4 show the Enroute Info page.

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help

Erroute Data

The FAR rinirnumn load Factor for thiz aiplane = 3.800

IF you want a areater load factor, enter pour greater load Factor.

Do you have an enroute canfiguration [like drive brakes] ? MO -

Enter Mach number at which aero coefficients were obtained [usually about 0.1]

Figure 11.3 Flight Loads: Enroute Info Page with no enroute configuration
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11 Flight Loads

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help

General] Spesd & Al Enroute Info ] Cruise Cosf | Cruize CG | Enroute Coef | Enroute CG | Landing Coef | Landing

Enroute Data

The FAR minirum load Factor far thiz aiplane i 3.800

If pou want a greater load factar, enter your greater load factor,
Do pow have an enroute configuration [like drive brakes] 7
Aire flaps extended for enroute configuration 7

Enter Mach number at which aero coefficients were obtained [usually about 0.1]

Figure 11.4 Flight Loads: Enroute Info Page with enroute configuration
pages visible

The FAR minimum load factor for the airplane is calculated based on the
category selected and the maximum airplane weight. The user also has the
flexibility to change the value of load factor if desired.

Input pages designated by the cruise, landing and enroute coefficients and
respective CGs are shown in figures 11.5 through 11.11. These pages are used
to enter data for cruise, landing and enroute configurations. Each configuration
requires two input pages: first where the coefficients for lift (Co, C4, Cp, C3 and
C,), drag (Do, D4, D2, D3 and D4) and pitching moment (Mo, M4, M2, M3 and M)
equations are entered, and second the CG data for each configuration.
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11 Flight Loads

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help

Cruize Coefficients

Enter Stall CL for cruise Enter Neg Stall CL for cruise

Enter 5 Coefficients for Lift in Equation : CL=CO+C1#ALPHA+C25ALPHA ™ 2+C3ALPHA ™ 3+C4*CLPHA ™
o 1 C2 C3 C4
032 | (.08 IE IE |0 |

Enter & Coefficients for Drag in Equation : CO=D0+D1*CL+D2*CL"2+D 3 CL"3+D4*CL™4
1] D1 D2 D3 D4
|0.027 IE | [0.054 IE IE |

Enter 5 Coefficients for Pitching Maoment in Equation : Ch=0+kd 1"ALPHAH 258 L PHA ™ 2+k 37 ALPHA " 3+ 4L PHA ™4
kA0 k1 k2 k3 k44
[om7 | [0.004 |[o |[o | o |

Figure 11.5 Flight Loads: Cruise Coefficients

C:yFar23loadsko Place Single Engine General Aviation Aircraft. Far
File ©utput  Utilities  Help

Cruize CG
Enter Ci& Designation, W T, #CG, ZCG for each of the 4 weight loadings

CG WWeight [Lbz] HOG ZCG

First 'weight Loading ||:|31 | |34nn | |851 | |a3 |

Second Weight Loading ||:|32 | |34nn | |?? 43 | |a3 |

| | | |

| | | |

Third ‘wsight Loading ||:|33 |2ann |?2 B4 |92
Fourth ‘weight Loading ||:|34 |2ns3 |an.?3nm

Figure 11.6 Flight Loads: Cruise CG
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11 Flight Loads

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help

Enroute Coefficients

Enter Stall CL for Landing Enter Meg Stall CL for Landing

Enter 5 Coefficients for Lift in Equation : CL=CO+C1#ALPHA+C22ALPHA ™ 2+C 3 AL PHA ™ 3+C4*CLPHA ™4

Co 1 C2 C3 C4

032 | (.08 IE IE |0 |

Enter 5 Coefficients for Drag in Equation : CO=00+01*CL+D2CL"2+03*CL"3+D4*CL"4
Lo L1 02 03 04

|0.027 IE | [0.054 IE IE |

Enter 5 Coefficients for Pitching Maoment in Equation Ch=t0+kd 1AL PHAHM 258 L PHA™ 2+h 37ALPHA ™ 3+ 4 8L FHA ™4
k40 b1 b2 b3 b4

[om7 | [0.004 |[o |[o | o |

Figure 11.7 Flight Loads: Landing Coefficients

C:yFar23loadsko Place Single Engine General Aviation Aircraft. Far
File ©utput  Utilities  Help

Landing CG
Enter Ci& Designation, W T, #CG, ZCG for each of the 4 weight loadings

CG Weight [Lbs) HOG ZCG
First Weight Loading  [CG5 | [3400 | |851 WEE |
SecondWeight Loading |{CGE | [3400 | [77.4 WEE |
Third Weight Loading ~ [CG7 | [2800 | [7264 | |92 |
Faurth Weight Loading  {CGE | |2083 | [7209 | [90.73001 |

Figure 11.8 Flight Loads: Landing CG
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11 Flight Loads

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help

Enroute Coefficients

Enter Stall CL for enroute Enter Meg Stall CL for enraute D

Enter 5 Coefficients for Lift in Equation CL=CO+C1#ALPHA+CZ#ALPHA "2+ C AL PHA ™ 3+ C4TLPHA
o 1 C2 C3
032 | (.08 IE IE |0 |

Enter & Coefficients for Drag in Equation : CO=D0+D1*CL+D2*CL"2+D3*CL"3+D4*CL"4
1] D1 D2 D3 D4
|0.027 IE | [0.054 IE IE |

Enter 5 Coefficients for Pitching Maoment in Equation Ch=t0+kd 1AL PHAHM 258 L PHA™ 2+h 37ALPHA ™ 3+ 4 8L FHA ™4
l1] k1 k2 k3 k44
[om7 | [0.004 |[o |[o | o |

Figure 11.9 Flight Loads: Enroute Coefficients

C:yFar23loadsko Place Single Engine General Aviation Aircraft. Far
File ©utput  Utilities  Help

Enroute CG
Enter Ci& Designation, W T, #CG, ZCG for each of the 4 weight loadings

CG Weight [Lbs) HOG ZCG
First Weight Loading | HE | [0 | [0 |
Second Weight Loading | HE | [0 | [0 |
Third Weight Loading | HE | [0 | [0 |
Faurth Weight Loading | HE | [0 | [0 |

Figure 11.10 Flight Loads: Enroute CG

The data necessary to make these load calculations comes from the results of
the respective modules when output data from these modules are updated.

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:
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11 Flight Loads

File:

o Save Data for SELECT Module — Enables user to save data in a
format that can be read by the SELECT module. This module is
inactive initially. After the user previews the output, this menu becomes
active and the user can save the data with a desired file name.

Help: The Help menu has only one option. It provides help on how to use
the flight loads module.

11.3 Flight Loads Output

The output from the ‘Flight Loads’ module is used in the ‘Select’ and ‘Wing
Inertia’ modules. Data for each point on the flight envelope is included in the
output file. The following data is included and if applicable, the variable name
used in the output file is given:

Name of the condition and case number

Altitude (feet) and equivalent air speed (knots)

Normal load factor n,

Angle of attack a (degrees)

Compressibility factor (variable G CORR)

Wing lift coefficient C.

Pitching moment of airplane less tail (variable M(W+F))

Wing lift normal to the airplane reference line (lbs) (variable LZW)
Tail load (Ibs) (variable LT)

Airplane drag load (Ibs) (variable DX)
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12 Selection of Critical Loads
12.1 Selection of Critical Loads Description

The critical flight loads are determined by the ‘Select’ module using the results of
the ‘Flight Loads’ module. The output from the ‘Flight Loads’ module contains all
of the balanced symmetrical flight conditions on the V-n diagram. ‘Select’
searches this file for the critical flight loads on the wing, fuselage, horizontal tail,
and vertical tail. Critical loads for other structures such as ailerons, flaps, engine
mounts, landing gear and tabs are determined in other modules as explained
later.

In addition to the flight envelope data, additional geometry and inertia data from
the ‘Weight & CG’ and ‘Envelope of Loading’ modules are required.

12.2 Running the Select Module

To run ‘Select’, click the module from the main window. The main input window
appears as shown in figure 12.1. All buttons except the exit button are inactive
initially. The File menu contains only one submenu:

e Read V-n Flight Loads Data — Enables user to select the flight loads file
that was saved in the Flight Loads module using the Save Data For
SELECT Module.

After the user selects an appropriate file (an error message appears if the file
does not contain the flight loads data that can be read by this module), the
Critical Wing Loads, Critical Horizontal Tail Loads, Critical Vertical Tail Loads,
and Critical Fuselage Loads buttons are activated.

51



12 Selection of Critical Loads

C:yFar23loadsko Place Single Engine General Aviation Aircraft. Far

File

i

Figure 12.1 Select Critical Loads Main Window

Figure 12.2 shows the critical wing loads window. Inputs required for this window
are the full aileron deflection and the airfoil section moment coefficient for no
aileron. The values in textboxes with yellow background are updated

automatically from respective modules.

C:yFar23loadsko Place Single Engine General Aviation Aircraft. Far
File ©utput  Utilities  Help
Critical “Wing Loads ]

Enter full dowr aileron deflection [Deq)
Enter airfoil section moment coefficient for no aileron deflection

Figure 12.2 Critical Wing Loads Window

Figure 12.3 shows the critical horizontal tail loads window. The values in
textboxes with yellow background are updated automatically from respective

modules.

52



12 Selection of Critical Loads

C:yFar23loadsko Place Single Engine General Aviation Aircraft. Far

File ©utput  Utilities  Help

Critical Horizontal T ail Loads ]

Slape of lit curve of wing (CL/Fad) Elevator area (Total LH+RH) (5371
|nizidence of hariz. tail, WL to chord [Deg Azpect ratio of horizontal tail
Harizontal tail area [Sg-Ft) Angle WL to zero lift line of wing far -Cruize
Enter aspect ratio of wing Landing
Full elevator deflection: up tralling edae [Deg] E nroute D
Full elevator deflection: down trailing edae [Deg] Length aof airplane [Ft]
Elevator area farward of hinge line (Total LH+RH) [53-F1 FS of 25% MAC of tai
Elevator area aft of hinge line (T otal LH+RH) (551 FS of 50% MAC of tai

Figure 12.3 Critical Horizontal Tail Loads Window

Figure 12.4 shows the critical vertical tail loads window. The values in textboxes
with yellow background are updated automatically from respective modules. The
user is asked if the default moment of inertia will be used to calculate the gust on
vertical tail. If the user selects YES, then default values are used; otherwise, the
user is asked to input the values manually.

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help
Critical Yertical T ail Loads |

Enter Full deflection of rudder [Deg] Enter length of airplane [Ft) 26.522
Enter wertical tail total area [Sq-Ft) 14.84 Enter wing zpan [Ft]
Enter rudder area [Sq-Ft] 5.236 Enter arozs weight af airplane [Lbs) 3400
) _ WAl you use default moment of inertia lzz to
Area of rudder fwd of hinge line [Sg-Ft) calculate gust on veritcal tail TES hd

Area of rudder aft of hinge line [Sg-Ft]
Enter aspect ratio of vertical bai
Enter MAC of vertical tail [Ft]
Enter F525% MAL of vettical tai

Figure 12.4 Critical Vertical Tail Loads Window

Figure 12.5 shows the critical fuselage loads window. Data required for this
submodule are the location where the engine is mounted and the wing weight.
Default wing weight is taken as 0.9 times the gross weight.
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12 Selection of Critical Loads

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help

Critical Fuzelage Loads ]

Where iz the engine mounted 7 |'W'ing j

‘whatis wing weight Lbs] I ]

[Leave the inputbox blank for a default value of 0.9 & grozs weight)

Figure 12.5 Critical Fuselage Loads Window

After entering the data for a component, the critical loads for that component
must be saved before moving to the next component. Each submodule has a
similar menu structure as described below.

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e Help: The Help menu has only one option. It provides help on how to use
the select module.

12.3 Select Module Output

‘Select’ determines the critical loads for the wing, fuselage, vertical tail, and
horizontal tail. A separate output file is created for each component. The output
file lists each critical condition with appropriate parameters.

The results from this module are used in the ‘Air Loads’, ‘Wing Inertia’, and ‘Tail
Load Distribution” modules.
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13 Aileron Loads

13.1 Aileron Loads Description

The loads on the aileron are calculated in the module ‘Aileron Loads’. The
deflected positions during unsymmetrical flight conditions produce the critical
loads.

To calculate the aileron loads, the required data include:
e Airspeeds Va, Vc and Vp
e Area of aileron forward and aft of hinge line
e Maximum up deflection at Va

e Maximum down deflection at Va

13.2 Running the Aileron Loads Module

To run ‘Aileron Loads’, click the module from the main window. The main input
window appears as shown in figure 13.1. The values in textboxes with yellow
background are updated automatically from respective modules.

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ltilities  Help

Aileron Loads
Enter max down aileron deflection [Degrees) 13
Enter max up aileron deflection [Degrees)
Enter aileron area Fwd of hinge line [S9-Ft)
Enter aileron area Aft of hinge line [Sg-Ft)
Enter ztructural speed (Knots] ; Ya
Ve 170

d

I

Figure 13.1 Aileron Loads Main Window

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
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13 Aileron Loads

option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e Help: The Help menu has only one option. It provides help on how to use
the aileron loads module.

13.3 Aileron Loads Output

The output from this module includes the up and down aileron deflections at Va,
Vc and Vp. The critical load for the up and down aileron deflection and the
pressure forward of the hinge line for up and down aileron is calculated.

Thezdeﬂection is given in degrees, the critical load in pounds, and the pressure in
Ib/in”.
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14 Flap Loads

14.1 Flap Loads Description

The ‘Flap Loads’ module calculates the critical flap loads determined by
calculating the lift on the flap due to wing angle of attack plus lift on the flap due
to the deflection of the flap.

To calculate the flap loads, the required data include:

e Stalling speed at maximum takeoff weight with flaps retracted (knots)
e Stalling speed at maximum takeoff weight with flaps extended (knots)
e Design flap speed (knots)

e Maximum takeoff weight (Ibs)

e Gust load factor with flaps extended

e Flap area on one side of airplane (ft?)

e Total area of wing (ft?)

e Maximum flap deflection (degrees)

e Ratio of flap chord to wing chord

e Maximum horse power of one engine

e Butt line of engine (in)

e Frontal area of nacelle (ft?)

e Propeller diameter (in)

14.2 Running the Flap Loads Module

To run ‘Flap Loads’, click the module from the main window. The main input
window appears as shown in figure 14.1. The values in textboxes with yellow
background are updated automatically from respective modules.
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14 Flap Loads

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far

File Qutput  Ltilities  Help
Flap Loads

Enter computed stalling speed at take-off Eriter tatal area of wing [5q-Ft) 184121

weight with flaps retracted [FKnots)

Enter computed stalling speed at take-off Enter max flap deflection [Degrees)

weight with flaps extended [Knotg) ) )
Enter ratio of flap chard to wing

Enter chosen design Hap speed [Knots) chord (fike 0.25]

[Ses Structural Speeds] Enter max HP of one engine 50

Enter max take-off weight [Lbsz) 3400

Enter max gust load factor with flaps 1.3 Enter frontal area of fuselage or
extended nacelle [Sq-Ft)

Enter flap area on ane side [Sq-Ft] 21.62 Erter propeller diameter [Inch]

Enter butt line of engine

[} [5=) [ =) =
= P i =1
oh
fan)

Figure 14.1 Flap Loads Main Window

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e Help: The Help menu has only one option. It provides help on how to use
the aileron loads module.

14.3 Flap Loads Output

The output from this module includes the lift coefficients for the wing and flap as
well as the flap load for the following conditions:

e 1 gstall

e 2gstall

e 2gatVe

e 19gatVe

Additional output includes the critical flap load and the pressure at the leading
edge. The butt line for the inboard and outboard edge of the slipstream velocity
are given as well as the slipstream velocity at the flap. For a horizontal gust of 25
fps, the factor to increase the flap load at V¢ and the critical flap load combined
with the horizontal gust are given.
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15 Wing Inertia

15.1 Wing Inertia Description

The ‘Wing Inertia’ module calculates the spanwise inertia shears and moments
for a balanced and accelerated flight condition along the quarter chord of the
wing for the critical wing conditions. Concentrated weights such as landing gear,
engines, fuel tanks, and external wing stores are accounted for in the
calculations.

Using the coordinates of the leading and trailing edges, the wing is divided into
incremental chordwise strips. For each strip, the inertia loads, shears, and
moments are calculated.

The inputs required for this module includes wing panel weight, inertia factors
obtained for the selected critical wing loads, ratio of densities of the tip area to
the root area, wing plan-form geometry, dihedral angle of the wing reference
plane and waterline of its intersection with the center plane of symmetry at the
quarter chord, weight and coordinates of the concentrated weights, wing station
of inboard rib of wing panel, and the load conditions.

15.2 Running the Wing Inertia Module

To run ‘Wing Inertia’, click the module from the main window. The main input
window appears as shown in figure 15.1. The values in textboxes with yellow
background are updated automatically from respective modules.

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help

Wing Geometry
How many points define the How maty points defing the
leading edge 7 trailing edge 7
Point # = [In] ¥ [In] i‘ Paint # = [In] ¥ [In] -
[+ = aft] [+7" = outboard) [+ = aft] [+7" = outboard)

—F 1. rE_1F ] .

Enter the BL or wing station of the inboard rib of the wing panel [In) I:I

Enter the number of spanwise elements the wing iz divided into I:I
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15 Wing Inertia

Figure 15.1 Wing Inertia Main Window

The main window has 3 data entry pages:

1. Wing Geometry: Contains information for carrying out wing geometry
calculations

2. Weight Data: Contains information about different weight data

3. Load Data: Contains information about different loads and points of
application

In the first window, the wing plan-form geometry (entered as leading and trailing
edge coordinates), wing station of inboard rib of the wing panel, and number of
wing spanwise increments (between 2 and 100) are entered.

In the second window, the wing panel weight (Ib) not including concentrated
weight, dihedral angle of the wing reference plane and waterline of its
intersection with the center plane of symmetry at the quarter chord, and weight
and coordinates for concentrated weights are entered. Figure 15.2 shows the
weight data page.

C:3Far23loadsks Place Single Engine General Aviation Aircraft. Far
File ©utput  Utilities  Help

YWeight Data
Enter maximurn number of concentrated weight to be congidered
Enter concentrated weight on wing [Lbs] and co-ordinates [In) il
CwT =OWT TOWT ZOWT
) O | | IR | O
Enter WL wing reference plane at plane of symmetry of airplane (1]

Enter zlope of wing reference plane [Deq) IZI

Ywhat iz the weight of wing panel [do not include concentrated weight] [Lbsz)

Figure 15.2 Wing Inertia: Weight Data Window

In the third window, the ratio of densities of the tip area to the root area and load
conditions including case number, N,, Ny and unbalanced moment are entered.
Figure 15.3 shows the load data window.
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15 Wing Inertia

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help

Load Data
Wwhat is ratio of density of tip area relative to root area -
[0/ root iz 0.2 Lbe/Sg-ln and itp iz 018 Lbe/Sgln)
How maty load conditions will pou enter’? I:I

Enter each lnad combination of case no., Mz, Nk, Linbaltdom --- chozen zo that inertia will act in
direction desired remembering up and aft are poszitive.

Caze Mo. Mz M= Inbalkd o i‘
1 |22 REE | [0.6085 | [o |
=~

Figure 15.3 Wing Inertia: Load Data Window

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e File:

o Save Data for NETLOADS Module — Enables user to save data in a
format that can be read by the NETLOADS module. This module is
inactive initially. After the user previews the output, this menu becomes
active and the user can save the data with a desired file name.

e Help: The Help menu has only one option. It provides help on how to use
the wing inertia module.

15.3 Wing Inertia Output

For each case, the output includes the load, shear, and torsion for each
spanwise increment of the wing. This output is used in the ‘Net Loads’ module
when determining the total loads.

In the output file, the data is labeled by the variable names. These variable
names are defined below:

e Input case number (Case)
e Input load factors for the X and Z directions (Nx and Nz)
e Rate of change of pitch velocity (THETADOT)
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15 Wing Inertia

Input value of unbalanced moment (in-lbs) (UNBAL MOM)

Coordinates of the quarter chord for the wing increment (in) (X, Y and Z)
Total inertia force in the X and Z directions (FX and FZ)

Incremental torsion (in-Ibs) (DMYY)

Total drag force in X and Z directions (lbs) (SX, SZ2)

Bending moment, torsion, and yawing moment (in-lbs) (MXX, MYY and
MZZ)
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16 Net Loads

16.1 Net Loads Description

The module ‘Net Loads’ calculates the spanwise net wing shears and moments
along the quarter chord of the wing. The air loads and inertia loads are
algebraically added to determine the net loads.

The input data required for the calculations are the air loads and inertia loads for
the selected critical wing loads. The air loads come from the ‘Air Loads’ module
and the inertia loads come from the ‘Wing Inertia’ module.

16.2 Running the Net Loads Module

To run ‘Net Loads’, click the module from the main window. The main input
window appears as shown in figure 16.1.

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
File oQutput  Utilities Help

Mo airloads file attached pet.

Mo wing inertia loads file attached pet.

Figure 16.1 Net Loads Main Window

In this module, the loads files saved from the air loads and the wing inertia loads
modules are attached and the analysis is performed. Initially, when no files are
attached, the window appears as shown in figure 16.1.

From the file menu, select the submenu ‘Open Air Loads File’ to attach the air
loads file. If this file is not the one that was saved from the ‘Air Loads’ module for
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16 Net Loads

the ‘Netloads’ module, then an error message will pop up. Figure 16.2 shows the
error message that appears when the wrong air loads file is attached.

L3
\14) THIS FILE DOES MOT COMTAIN DATA OF AIRLOADS LSED BY METLOADS MODULE

Figure 16.2 Error Message when wrong Air Loads file is Attached

From the file menu, select the submenu ‘Open Wing Inertia File’ to attach the
wing inertia file. If this file is not the one that was saved from the ‘Wing Inertia’
module for the ‘Netloads’ module, then an error message will pop up. Figure 16.3
shows the error message that appears when the wrong wing inertia file is
attached

L
\lj‘) THIS FILE DOES MOT COMTAIN DATA OF WING IMERTIA LOADS USED BY METLOADS MODULE

Figure 16.3 Error Message when wrong Wing Inertia file is Attached

When the correct air loads and wing inertia files are attached, the main window
appears as shown in figure 16.4. Analysis can be performed once both correct
files are attached. If the air loads and wing inertia files do not contain a common
case number, an error message appears. Figure 16.5 shows the error message
when the program fails to find a common case number.
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16 Net Loads

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far E”E'E'
File oQutput  Utilities Help

Airloads File Airloads to Metloads. Far

Wing Inertia Loads File:  “Wing Inertia to Metloads.Far

Figure 16.4 Net Loads Main Window with both Correct files Attached

ERROR MESSAGE X

@ MO CASE WAS FOURMD IM WING INERTIA LOADS FILE THAT MATCH THE AIR LOADS CASE,

PLEASE REATTACH THE FILES WITH COMMON CASE MUMEBER FOR AIRLOADS ARD WING INERTIA LOADS,

Figure 16.5 Error Message when no Common Case is Found

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e File:

o Open Air Loads File — Enables user to open the file that had been
saved in the ‘Air Loads’ module that saved data that can be opened in
Net Loads module.

o Open Wing Inertia File — Enables user to open the file that had been
saved in the ‘Wing Inertia’ module that saved data that can be opened
in Net Loads module.

e Help: The Help menu has only one option. It provides help on how to use
the net loads module.
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16 Net Loads

16.3 Net Loads Output

The output includes the spanwise net wing loads, shears, and moments along
the quarter chord of the wing. In the output file, the data is labeled by the variable
names. These variable names are defined below (positive direction is up and aft):

e Coordinates of the quarter chord (X, Y and Z)

e Normal force in the X and Z directions (Ib) (FX and F2)
e Drag and shear loads (Ib) (SX, SZ)

e Moments (in-Ib) (MX, MY, MZ)
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17 Engine Mount Loads
17.1 Engine Mount Loads Description

The ‘Engine Mount Loads’ module calculates the loads on the engine mount and
its supporting structure. These loads include those resulting from engine torque
loads, vertical inertia loads, and side inertia loads. For turbine engines, the
torque due to sudden stoppage is also included. For turbine-powered airplanes,
the gyroscopic and aerodynamic loads resulting from the combination of yaw
velocity, pitching velocity, normal inertia loads, and propeller thrust must be
considered.

17.2 Running the Engine Mount Loads Module

To run ‘Engine Mount Loads’, click the module from the main window. The main
input window appears as shown in figure 17.1. The values in textboxes with
yellow background are updated automatically from respective modules.

C:3Far23loadsks Place Single Engine General Aviation Aircraft. Far
File ©utput  Utilities  Help

E nagine
Enter engine manufacturer and designation |Internatinnal I0-520-BB |
Enter limit load factar, M Select engine pe RECIPROCAL ﬂ
Enter engine weight [Lbsz)
Enter Engine CG: ¥ Co-Ordinate [In]

YCoOdinatein) [0 |

Z Co-Drdinate (In]

Figure 17.1 Engine Mount Loads Main Window

The main window has 3 data entry pages:
4. Engine: Contains general engine data
5. Propeller: Contains propeller data
6. Engine Details: Contains engine details
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17 Engine Mount Loads

In the first window, general engine data such as manufacturer, type, limit load
factor, weight, and CG coordinates are entered.

In the second window, shown in figure 17.2, propeller data is entered. This data
includes manufacturer, weight, takeoff RPM, max continuous RPM, diameter,
number of blades, and CG coordinates.

C:3Far23loadsks Place Single Engine General Aviation Aircraft. Far
File ©utput  Utilities  Help

Fropeller

Enter propeller manufacturer and dezignation |M'3DUff.'r' 354 |

Enter propeller weight [Lbsz) Enter propeller CG:

Enter propeller take-off RPk # Co-Ordinate [In]
Enter propeller max continuousz BPM Y Co-Ordinate [In] D
Enter propeller diameter [In) £ Co-Ordinate [In)

Enter number of propeller blades

Figure 17.2 Engine Mount Loads Propeller Window

In the third window, shown in figure 17.3, further engine details such as takeoff
HP, max continuous HP, and number of cylinders are entered. Depending on the
type of engine selected on the Engine page, the required data changes. If the
user selects ‘Reciprocal’ engine, engine details are as shown in figure 17.3; if the
user selects ‘Turboprop’, engine details are as shown in figure 17.4.
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17 Engine Mount Loads

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help

Engine Details

Enter take-off HF
Enter maximurm continuous HP 265

Enter number of cylinders IZI

Figure 17.3 Engine Mount Loads Engine Details Window (Reciprocal
Engine)

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help

Engine Detailz

Enter number of ratars

Fotor Murnber 1
Enter rotor diameter [Ir] I:I i‘
Enter time in seconds to stop due to

Enter rotor weight [Lbs]
sudden stoppage. FAA uzually I:I
geeeill e Enter rator maximurn B Pk I:I ﬂ

Enter maximurn engine torque [Ft-Lbz]
Enter cruize engine targue [Ft-Lbz]

Enter propeller hub weight [Lbz]

2 q
w o o

Figure 17.4 Engine Mount Loads Engine Details Window (Turboprop
Engine)

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e Help: The Help menu has only one option. It provides help on how to use
the engine mount loads module.
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17 Engine Mount Loads

17.3 Engine Mount Loads Output

For reciprocating and turboprop engines, the output includes results for the
following conditions:

e Limit takeoff torque with 75% limit maneuver vertical load factor

e A factor times the maximum continuous torque with 100% limit maneuver
vertical load factor

e Side load independent of other flight loads

The results include the vertical load factor and load, the coordinates where the
load acts, and the engine torque. For the side load, the vertical and side load
factors are given, as well as the coordinates where the load acts. For each
condition, the applicable FAR requirement is specified.

For turboprop engines, additional results are included in the output file. These
include the loads for turboprop propeller malfunction, torque for sudden stoppage
due to malfunction, and gyroscopic loads.
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18 Landing Loads

18.1 Landing Loads Description

The ‘Landing Loads’ module calculates the landing loads for a tricycle landing
gear with spring or oleo struts. The main and nose gears do not have to be the
same type of gear.

The inputs required for calculation of the landing loads include the landing
weight, landing gear load factor, assumed lift factor during landing, the station
and waterline of the axles for the static position, rolling radius of the tires,
distance between main wheels, tail down bump angle, and the weight and CG for
the structural limits.

18.2 Running the Landing Loads Module

To run ‘Landing Loads’, click the module from the main window. The main input
window appears as shown in figure 18.1. The values in textboxes with yellow
background are updated automatically from respective modules.

C:%Far23Loadsy6 Place Single Engine General Aviation Aircraft. Far

File ©ukput  Ukilities  Help

i..ﬁ,anaml.lnf.mmatiwn.é] Gear Specific Infarmation |
General [nformation
b ax landing weight [Lb] Dezign max weight [Gross weight] [Lb]
Gear load factar ‘wing lift Factar [L <0 657)
Select M ain gear type Im Select noze gear type m

MG. % (In) MG Z(n MG =[] NG, Z (In]

¥ & Z values for MG & NG at 25% deflection |36.3 | 559 |19 | [46.3 |
# & Z values for MG & NG for Static deflection |36.7 | 535 |24 | [49.5 |
¥ %2 values for MG & MG for Fully extended deflection |E"3-2 | |54-2 | |'I B | |45-4 |

Figure 18.1 Landing Loads Main Window (General Information)

The main window has 2 data entry pages:

1. General Information: Contains general information about the landing
gear
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18 Landing Loads

2. Gear Specific Information: Contains specific information about the
landing gear

In the first window, shown in figure 18.1, maximum landing weight, design
maximum (gross) weight, landing gear load factor, lift factor during landing, type
of struts (oleo or spring), the wing station and waterline of the gear axles for the
static deflection and fully extended deflection, for oleo struts, the wing station and
waterline of the gear axles for the 25% deflection and for spring struts, and the
wing station and waterline of the gear axles for the 25% deflection are entered.

In the second input window, shown in figure 18.2, rolling radius of the tires,
distance between main wheels (tread), tail-down bump angle, and weight and
CG for the structural limits are entered.

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ltilities  Help

General Infarmation i....E.E!.al.ﬁnﬂmific..lnfﬂrmatiﬂn.?]

Gear Specific Information

Main gear ralling radiuz [Inch) Mose gear roling radiuz [Inch)
Tread [Distance between two wheelz] [114.5 Ground angle for tail down altitude 15
Wi 1145 | N

meazured from GL to a WL [Degreesz)

CG# WICG [LE] HEG [In] ZLG [In]
For AFT max landing weight |5 | |323EI | |85'-I | |EB |
Faor F/D max landing weight |5 | |323U | |?E.12 | |E|3 |
For Pw/D light landing weight 7 | [2800 | [7284 REE |

Figure 18.2 Landing Loads Main Window (Gear Specific Information)

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e Help: The Help menu has only one option. It provides help on how to use
the landing loads module.
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18 Landing Loads

18.3 Landing Loads Output

In the output file of this module, the input data is listed. The type of landing gear
is not given explicitly. For oleo struts the X and Z coordinates are given for the
25% deflection, while for the spring struts the coordinates are given for the 100%
deflection.

The ‘Landing Loads’ module calculates the ground reactions and load factors as
well as unbalanced moments. The ground reactions and load factors are given
relative to the ground line and with respect to the airplane datum.
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19 Landing Load Factor
19.1 Landing Load Factor Description

When test data is not available, the landing load factor is estimated in this
module. This load factor is used in the calculation of landing loads. After test data
is available, the load factor should be revised.

19.2 Running the Landing Load Factor Module

To run ‘Landing Load Factor’, click the module from the main window. The main
input window appears as shown in figure 19.1. The values in textboxes with
yellow background are updated automatically from respective modules.

C:%Far23Loadsy6 Place Single Engine General Aviation Aircraft. Far
File ©ukput  Ukilities  Help
Landing Load Factor
Enter tatal wing area [Sq-Ft)

Enter outer diameter of tire [Inch) _
Select main gear type m
Enter landing weight [Lbs]
Enter diameter of hub [Inch)
Enter lift factor [less than 0.657)

YWwhat iz stroke of strut from fully extended to fully compressed [Inch]

Figure 19.1 Landing Load Factor Main Input Window

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e Help: The Help menu has only one option. It provides help on how to use
the landing load factor module.
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19 Landing Load Factor

19.3 Landing Load Factor Output

This module produces the following output:
e Sinkrate
e Airplane load factor

e Landing gear load factor

The landing gear load factor is used in the ‘Landing Loads’ module when test
data is not available.
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20 Tail Loads Distribution

20.1 Tail Loads Description

The ‘Tail Loads Distribution’ module calculates chordwise distributions on the
average chord for critical horizontal and vertical tail loads. It also calculates the
chordwise distribution for any tail station for any of the critical loads. There are
thirteen critical horizontal tail loads and four critical vertical tail loads.

20.2 Running the Tail Loads Module

To run the ‘Tail Loads Distribution’ module, click the module from the main
window. The main input window appears as shown in figure 20.1. The first
window allows the selection of 13 critical horizontal tail loads on average chord, 4
vertical tail loads on average chord, and 1 critical horizontal tail load or critical
vertical tail load distributed on N station chords. It also provides the flexibility to
return to the main menu by clicking on the close button.

C:3Far23loadsks Place Single Engine General Aviation Aircraft. Far

13 Critical horizontal tail loadz distributed on average chord

4 Critical vertical tail loads distributed on average chord

1 Critical horizontal tail load distributed an M ztation chards

1 Critical vertical tail load distibuted on M station chords

&

Figure 20.1 Tail Loads Distribution Main Window

Clicking on the first button opens the 13 critical horizontal tail loads submodule
shown in figure 20.2. This submodule has 3 pages:

e Area: Contains information about different areas required to calculate
critical loads as shown in figure 20.2
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20 Tail Loads Distribution

e Load Cases 1-6: Contains loads due to angle of attack at 25% MAC and
due to camber at 50% MAC for cases 1 through 6 as shown in figure 20.3.

e Load Cases 7-13: Contains loads due to angle of attack at 25% MAC and
due to camber at 50% MAC for cases 7 through 13 as shown in figure
20.4.

In the first window, the required input includes the area of the horizontal tail, area
of the elevator, area of the elevator forward and aft of the hinge line, and the
semispan of the tail.

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help

Enter area of LH horizontal tail [Sg-1n)
Enter area af LH elevator forward af hinge line [Saq-1n)
Enter area of elevator fwd of hinge line [Sg-1n)
Enter area of elevator aft of hinge line [Sg-n)
Enter zemizpan of tail [In]

Figure 20.2 13 Critical Horizontal Tail Loads Window (Area Page)

In the second and third windows, the loads due to angle of attack at the 25%
MAC and due to camber at the 50% MAC are entered for thirteen conditions.
These conditions are:

e Up and down balancing tail loads with flaps retracted
e Up and down balancing tail loads with flaps extended
e Up and down unchecked maneuver tail load

¢ Up and down checked maneuver tail load

e Up and down gust tail load with flaps retracted

e Up and down gust tail load with flaps extended

e Unsymmetrical tail load
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20 Tail Loads Distribution

The loads data come from the critical horizontal tail loads output from the ‘Select’
module. For the gust tail loads, both the incremental and total loads are given in
the ‘Select’ module. The total load is entered automatically. For the
unsymmetrical tail load, the ‘Select’ file does not list the loads, but it does identify
which case has the same distribution. The condition is not updated automatically.

C:3Far23loadsks Place Single Engine General Aviation Aircraft. Far
File ©utput  Utilities  Help

Loads due to angle of attack at 25% Loads due to camber at 0%
MALC [Total on LH+RH] [Lbs) MALC [Tatal LH+RH] [Lbs]

1. Up balancing tail lnad faps retracted 0394 -364.53

2. Down balancing tail load flaps retracted 200.51 -B16.ER

3. Up balancing tail load flaps extended -35.43 -£1.82

-435.72

4. Down balancing tail load flaps estended 03327
A. Unchecked maneuver down tail load [elesvator
trailing edae up]

E. Unchecked maneuver up tail load [elesvatar
trailing edge down)

-58.054 -1351.043

5g.872 165.660

I

Figure 20.3 13 Critical Horizontal Tail Loads Window (Load Cases 1-6 Page)

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help
#wea| Load Cazes: 16 Load Cases: 713 ]

7. Dowin load checked maneuwver tail load
8. Up load checked maneuwver tail load
9. Up gust tail load flaps retracted
10. Diown gust tail load flaps retracted
11. Up gust tail load flaps extended
12, Down gust tail load flaps extended -1083.841 159,278

13. Unzyrmetrical tail load -1186.31 10600

I

Figure 20.4 13 Critical Horizontal Tail Loads Window (Load Cases 7-13
Page)

Clicking on the second button in figure 20.1 opens the 4 critical vertical tail loads
submodule shown in figure 20.5. This submodule has 2 pages:
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20 Tail Loads Distribution

e Area: Contains information about different areas required to calculate
critical loads as shown in figure 20.5

e Loads: Contains loads due to angle of attack at 25% MAC and due to
camber at 50% MAC as shown in figure 20.6

C:yFar23loadsko Place Single Engine General Aviation Aircraft. Far
File ©utput  Utilities  Help
frea ] Loads|

Enter area of vertical tail [Sg-n] 2137.00
Enter area of rudder [Sg-In] 754.00

Enter area of rudder fwd of hinge line [Sq-ln)  |32.00

Enter area of rudder aft of hinge line [Sgln)  |687.00
Enter span of vertical tail 57.00

Figure 20.5 4 Critical Vertical Tail Loads Window (Area Page)

In the first window, the required input includes the area of the vertical tail, area of
the rudder, area of the rudder forward and aft of the hinge line, and the span of
vertical tail.

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help

Load an vertical tail due to angle Load an vertical tail due to
of attack at 25% MaC [Lbg) camber at 50 MALC [Lbs]

1. Manewver load for sudden full rudder deflection

k aneuver load for yaw to zidezlip of 19.5 deqg with

2. rudder maintained at full deflection -1076.00

3. Maneuver load for yaw of 15 deg with rudder in neutral — |-827.00

4. Side gust load at Yo 5000

iR EL
¢

Figure 20.6 4 Critical Vertical Tail Loads Window (Loads Page)
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20 Tail Loads Distribution

In the second window, the loads due to angle of attack at the 25% MAC and due
to camber at the 50% MAC are entered for four conditions. These conditions are:

e Maneuver loads for sudden full rudder deflection

e Maneuver loads for yaw to sideslip of 19.5° with rudder maintained at full
deflection

e Maneuver load for yaw of 15° with rudder in neutral

e Side gust load at V¢

The loads data are transferred automatically from the critical vertical tail loads
output file from the ‘Select’ module. Some of the loads may be zero. For zero
loads a numerical value of 0 should be entered.

Clicking on the third button in figure 20.1 opens the 1 critical horizontal tail loads
submodule shown in figure 20.7. This submodule has 2 pages:

e General: Contains information about the critical horizontal tail load to be
analyzed, different respective loads, and areas as shown in figure 20.7

e Loads: Contains data for each butt line station and respective loads data
as shown in figure 20.8

C:3Far23loadsks Place Single Engine General Aviation Aircraft. Far
File ©utput  Utilities  Help

Select one of the 13 horizontal tail load

conditions to be analysed |'I. Up balancing tail load flaps retracted ﬂ
Enter angle of attack laad (LH+FH] at 25% MAC [Lbs]
Enter camber load [LH+FH] at 50% MAC [Lbs]
Enter area of LH horizontal tail [Sg-n)
Enter area of LH elevator aft of hinge line [Sg-n)

Enter the number of BL stations far chordwizse load distibutions |5
[Mot mare than 10]

Figure 20.7 1 Critical Horizontal Tail Load Window (General Page)
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20 Tail Loads Distribution

In the first window, the name of the load condition, the angle of attack load at
25% MAC, the camber load at 50% MAC, area of one side of the horizontal tail,
area of the LH elevator aft of hinge line, and the number of butt line stations for
chordwise distribution are the required inputs. The values in textboxes with
yellow background are updated automatically when the load condition is selected
or changed by the user.

C:3Far23loadsks Place Single Engine General Aviation Aircraft. Far
File ©utput  Utilities  Help

General  Loads ]

Pt Murnber If
Butt line of a station for load digtribution [In] 11.5 i‘
Chord of horizontal tail at that BL ST4 [In)
Chord of elevator at that BL 5T (In)

Chord of elewvatar aft of hinge line at that BL STA [In] 18193 ﬂ

Figure 20.8 1 Critical Horizontal Tail Load Window (Loads Page)

In the second window, data for each butt line station is entered in inches. The
data required is as follows:

e Butt line of the station
e Chord of horizontal tail at the butt line station
e Chord of elevator at the butt line station

e Chord of elevator aft of the hinge line at the butt line station

The number of inputs for the above mentioned data depends upon the number of
BL stations entered in the ‘General’ page. The maximum value allowed is 10.

Clicking on the fourth button in figure 20.1 opens the 1 critical vertical tail loads
submodule shown in figure 20.9. This submodule has 2 pages:
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20 Tail Loads Distribution

e General: Contains information about the critical vertical load to be
analyzed, different respective loads, and areas as shown in figure 20.9

e Loads: Contains data for each water line station and respective loads data
as shown in figure 20.10

C:yFar23loadsko Place Single Engine General Aviation Aircraft. Far
File ©utput  Utilities  Help

Select one of the 4 vertical tail

load conditions to be analyzed |1. M aneuver load for sudden full rudder deflection ﬂ
Enter angle of attack laad [LH+FH] at 253 MAC [Lbs]
Enter camber load [LH+FH] at 503 MALC [Lbs)
Enter area of LH vertical tail [Sg-ln]
Enter area of rudder aft of hinge line [Sg-ln)
FNHQ?EE;EE?E;“:%? WL stations for chordwize load distributions

Figure 20.9 1 Critical Vertical Tail Load Window (General Page)

In the first window, the name of the load condition, the angle of attack load at
25% MAC, the camber load at 50% MAC, area of one side of the vertical tail,
area of the rudder aft of hinge line, and the number of water line stations for
chordwise distribution are the required inputs. The values in textboxes with
yellow background are updated automatically when the load condition is selected
or changed by the user.

In the second window, data for each water line station is entered in inches. The
data required is as follows:

e Water line of the station
e Chord of vertical tail at the water line station
e Chord of rudder at the water line station

e Chord of rudder aft of the hinge line at the water line station
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20 Tail Loads Distribution

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help

General Loads ]

Paint Murmber ’f
Wiater line of a station for load distribution [1r] i'
Chard of vertical tail at that WL STA [In)
Chard of rudder at that WL STA (In)
Chard of rudder aft of hinge line at that WL ST4 [In] =

Figure 20.10 1 Critical Vertical Tail Load Window (Loads Page)

The number of inputs for the above mentioned data depends upon the number of
WL stations entered in the ‘General’ page. The maximum value allowed is 10.

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

o File:

o Return to Tail Loads Menu — Enables user to close existing menu and
return to the main window of tail loads module from which other
submodules can be selected and run or the user can exit the tail loads
distribution module.

e Output: The Output menu is used to preview, save and print output and
also to update input / output data to other modules. The Output menu has
5 sub menus in 13 critical horizontal tail loads and 4 critical vertical tail
loads and has 4 sub menus in 1 critical horizontal tail loads and 1 critical
vertical tail load submodule. Details are as follows:

o Update Output To Other Modules (available in 13 critical horizontal and
4 critical vertical tail loads submodules only) — Updates output to
respective modules. Refer to table 2.1 for details of data flow between
modules. After the data is updated, a message box displaying the
names of modules to which data has been updated appears.

¢ Help: The Help menu has only one option. It provides help on how to use
the tail loads module.
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20 Tail Loads Distribution

20.3 Tail Loads Output

The results of this module are the chordwise distribution of critical loads for each
of the critical load conditions. For the horizontal tail, there are 13 critical
conditions; for the vertical tail, there are 4 critical conditions. The load distribution
is given at five chordwise stations. In the output, LT25 refers to the load due to
angle of attack at the 25% MAC and the LT50 refers to the load due to camber at
the 50% MAC. This is an echo of the input.
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21 Tab Loads

21.1 Tab Loads Description

The tab loads for the wing, horizontal tail, and vertical tail are determined in the
‘Tab Loads’ module. The loads are calculated for full deflection at VC at the
shoulder on the structural limit diagram. This is where V¢ is the highest in
equivalent airspeed (KEAS) with the greatest Mach number.

21.2 Running the Tab Loads Module

To run ‘Tab Loads’, click the module from the main window. The main input
window appears as shown in figure 21.1. The values in textboxes with yellow
background are updated automatically from respective modules.

C:AFar23loadsi6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Ltilities  Help
Tab Loads

Enter Wi [KE&AS) 171

Select the zurface on which the tab iz inztalled |HEIF|IZEINT.~'1'-.L TAIL j

Enter MAC of tab (Inch]
Enter area of tab [Sg-ln)
Enter buttine of tab MAC
Enter chaord of horizontal tail at 17828
Enter max deflection of tab [['egrees)

Figure 21.1 Tab Loads Main Window
The inputs required for tab loads calculations include:

e Cruise speed VC (KEAS)

e Surface of interest (wing, horizontal tail or vertical tail)

e The mean aerodynamic chord (MAC) for the tab (inches)
e The area of the tab (in?)

e Butt line of the MAC of the tab (inches)
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21 Tab Loads

e Chord of wind (inches)

e Maximum deflection of the tab (degrees)

Depending upon the surface selected, the prompts on the input window will
change.

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e Help: The Help menu has only one option. It provides help on how to use
the tab loads module.

21.3 Tab Loads Output

The output from this module includes the ratio of the tab to airfoil chord, the tab
load in pounds, and the tab pressure at the leading and trailing edges.
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22 One Engine Out Loads

22.1 One Engine Out Description

The loads for one engine out are calculated using this module. When one of the
engines fail, the primary force acting on the airplane is an unbalanced moment
about the vertical axis at the center of gravity of the airplane. The rotational
acceleration of the airplane about the vertical axis at the CG is resisted by the
mass moment of inertia of the airplane. As the airplane rotates, the vertical tail
provides an aerodynamic force that also resists the unbalanced moment.

22.2 Running the One Engine Out Loads Module

To run the ‘One Engine Out Loads’ module, click the module from the main
window. The main input window appears as shown in figure 22.1. The values in
textboxes with yellow background are updated automatically from respective
modules.

The input for this module is entered on two pages as shown in figures 22.1 and
22.2. On page 1, the following data is entered:

e Aspect ratio of vertical tail

e Area of vertical tail (in%)

e Area of rudder (in?)

e Maximum deflection of rudder (degrees)

e Fuselage station of the CG (inches)

e Fuselage station for the 25% MAC of the vertical tail (inches)

e Fuselage station for the 50% MAC of the vertical tail (inches)

e Speed (KEAS)

e Altitude (feet)

e Moment of inertia of the airplane about vertical axis, |7z (slug-ft?)

On page 2, the following data is entered:
e Buitt line of the engine (inches)
e Maximum horsepower of one engine
e Propeller diameter (ft)

e Time at which thrust decays to zero (seconds)
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22 One Engine Out Loads

e Time at which windmill drag builds to maximum (seconds)
e Time to develop full rudder deflection (seconds)

e Incremental time step (seconds) (suggested as 0.05)

Separate analyses are required for each speed. These include V¢, Vp and Vs.

C:AFar?3loadsy6 Place Single Engine General Aviation Aircraft. Far
File Qutput  Utilities Help
Page1 | Page 2 |

Enter aspect ratio of vertical tail 1.434 Enter fuselage station for 25% MAC vert tail [In]  |267.121

Enter area aof vertical tail [Sg-n] 2137392 Enter fuselage station for 0% MAC vert tail [In)  |277.161

Enter area of rudder [Sq-In) 789,612 Enter speed, ¥ [FEAS] 210
Erter max deflection of rudder [Deg)|20.000 Enter altitude [Ft] 24000

Ertter fuselage station for CG (] [134.4 Enter moment of inertia of airplane about vertical 41599

axiz, lzz [Slug Ft-5q]

Figure 22.1 One Engine Out Loads Main Window (Page 1)

C:yFar23loadsko Place Single Engine General Aviation Aircraft. Far
File ©utput  Utilities  Help
Page1 Page2 ]

Enter butt line of engine Enter time at which thrust decays to zero [Sec)
Enter max HP of one engine Enter tirme at which windmill drag buildz to mas [SEC]

Enter diameter of propeller [Ft]| 5. 2083 Enter incremental time step [zuch az 0.05] [Sec)
Enter length of time to develop full rudder

deflection [Sec)

Figure 22.2 One Engine Out Loads Main Window (Page 2)
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22 One Engine Out Loads

The input window is displayed when the module starts and is used to specify the
parameters for the analysis. The window includes 4 visible and 1 invisible menu
option(s). Details of the visible menus are described in Section 2 under the
headings File, Output, Utilities, and Input. Additional module menu items include:

e Help: The Help menu has only one option. It provides help on how to use
the one engine out loads module.

22.3 One Engine Out Loads Output

The output of this module includes the engine thrust in pounds, the windmill drag
in pounds, the maximum yawing velocity, and maximum tail load. The time
history provides the data from time zero until recovery is complete at the
specified increments. At each time increment, several parameters are printed.
These parameters along with the variable names are listed below:

e Time (TIME)

e Yaw angle (THETA)

e Angular velocity (THETADOT)

e Angular acceleration about the CG (THETA2DOT)
e Load at the 25% MAC (LT25)

e Load at the 50% MAC (LT50)

e Total Load (LT)

e Rudder deflection (degrees) (RUD DEFL)

e Moment (MOMENT)

In the time history, it is indicated when the engine thrust has decayed to zero,
when the windmill drag has built up to the maximum, when corrective action is
initiated, and when recovery is complete.
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Appendix A Input/Output Data for a 6 Place General Aviation
Airplane

A.1  Weight Estimation

ESTIMATED WEIGHT DATA FOR 6 PLACE SINGLE ENGINE GENERAL AVIATION AIRPLANE

INPUT

MAX CONTINUOUS HP 265
NUMBER OF ENGINES 1
NUMBER OF SEATS 6
HOURS AT CRUISE POWER 3
MAX BAGGAGE WEIGHT 0
UNPRESSURIZED

RECIPROCAL 4 CYCLE ENGINE
OUTPUT

MAX TAKE OFF WT 3468
USEFUL LOAD 1318
EMPTY WEIGHT 2150
W (EMPTY) /W (TO) .62
WING 359
FUSELAGE 340
TAIL 81
NACELLE 50
LANDING GEAR 198
CONTROLS 52
TOTAL STRUCTURE..... 1081
ENGINE INSTALLED 490
(INCLUDES PROPELLER(S)) ( 83)
FUEL SYSTEM 52
EXHAUST 72
OTHER ENGINE DETAILS 86
TOTAL POWRPLANT..... 700

INSTRUMENTS & NAV EQUIP 15

PNEUMATICS 3
ELECTRICAL 83
ELECTRONICS 0

FURNISHINGS & EQUIPMENT 152
ENVIRONMENTAL & ANTI-ICE 10
MISC OTHER SYSTEM WT 0

TOTAL SYSTEMS WEIGHT..... 268

OPTIONS & MISCELLANEOUS 99

EMPTY WEIGHT.......... 2150
PILOT 170
PASSENGER NO. 2 170
PASSENGER NO. 3 170
PASSENGER NO. 4 170
PASSENGER NO. 5 170
PASSENGER NO. 6 170
BAGGAGE 0

FUEL 298
USEFUL LOAD 1318

A1



Appendix A Input/Output Data for a 6 Place General Aviation Airplane

A.2 Weight and CG

ATRPLANE WEIGHT AND INERTIA

ITEM COMPONENT WEIGHT X Y 7 IXX IYyYy 1727
1 WING OUTBOARD 330.000 97.870 0.000 87.730 4444110.000 133485.000 4444110.000
2 HORIZONTAL TAIL 42.000 270.360 0.000 111.000 0.000 0.000 0.000
3 VERTICAL TAIL 23.000 276.930 0.000 137.760 0.000 0.000 0.000
4 MAIN GEAR WHEEL 45.000 97.000 0.000 69.000 0.000 0.000 0.000
5 MAIN GEAR STRUT 110.000 97.000 0.000 78.000 0.000 0.000 0.000
6 NOSE GEAR WHEEL 9.000 1.000 0.000 52.000 0.000 0.000 0.000
7 NOSE GEAR STRUT 40.000 1.000 0.000 65.000 0.000 0.000 0.000
8 FLIGHT CONTROL 57.000 123.000 0.000 105.000 0.000 0.000 0.000
9 NACELLE 62.000 21.000 0.000 92.000 0.000 0.000 0.000
10 ENGINE INSTALL 505.000 22.000 0.000 92.000 52604.000 81473.000 81473.000
11 PROPELLER 74.000 -10.000 0.000 100.000 0.000 0.000 0.000
12 SYSTEMS 88.000 60.000 0.000 100.000 0.000 0.000 0.000
13 FURINSHINGS 175.000 105.000 0.000 100.000 0.000 0.000 0.000
14 UNUSABLE FUEL 12.000 73.000 0.000 80.000 0.000 0.000 0.000
15 FUSELAGE STRUC 250.000 99.000 0.000 80.000 0.000 1131020.000 1131020.000
———————————————————————————————————————— END OF EMPTY WEIGHT ITEMS----—————————————————————————————
51 PILOT 170.000 75.000 0.000 100.000 28730.000 24480.000 4250.000
52 30 MIN FUEL 71.000 70.000 0.000 82.000 86975.000 0.000 86975.000
———————————————————————————————————————— END OF MINIMUM WEIGHT ITEMS---—————-——————————————————
61 COPILOT 170.000 75.000 0.000 100.000 28730.000 24480.000 4250.000
62 3RD PERSON 170.000 111.000 0.000 100.000 28730.000 24480.000 4250.000
63 4TH PERSON 170.000 111.000 0.000 100.000 28730.000 24480.000 4250.000
64 5TH PERSON 170.000 150.000 0.000 100.000 28730.000 24480.000 4250.000
65 6TH PERSON 170.000 150.000 0.000 100.000 28730.000 24480.000 4250.000
67 GUEL TO GR WT 409.000 70.000 0.000 87.000 501025.000 0.000 501025.000
68 BALLAST 78.000 103.700 0.000 90.000 0.000 0.000 0.000

———————————————————————————————————————— END OF DISCRETIONARY WEIGHT ITEMS——---—==--——=-——=—-——————

CENTER OF GRAVITY, WEIGHT & INERTIA

CENTER OF GRAVITY AND WEIGHT

XBAR (FUS STA) = 84.999
ZBAR (WATERLINE) = 92.579
WEIGHT (POUNDS) = 3400.000

INERTIAS WITH RESPECT TO AIRPLANE COORDINATES

IXX IYy VA IX7Z UNITS
1201.530 2058.218 3022.772 134.403 SLUG FEET SQUARED
5566065.738 9534655.502 14002928.764 622619.791 LBS INCHES SQUARED

INERTIAS WITH RESPECT TO PRINCIPAL AXES

IX(P) IY (P) Iz (P) UNITS
1191.665 2058.218 3032.637 SLUG FT SQUARED
5520365.471 9534655.502 14048629.031 LBS INCHES SQUARED

THETA = 4.198 (DEGREES, MEASURED UP FROM WL & AFT FROM CG)
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Appendix A Input/Output Data for a 6 Place General Aviation Airplane

A.3 Envelope of Loadings

AIRPLANE ENVELOPE OF WEIGHT VS CENTER OF GRAVITY FOR DISCRETIONARY LOAD

WEIGHT DATA FOR 7

ITEM COMPONENT WEIGHT X Y Z
1 WING OUTBOARD 330.000 97.870 0.000 87.730
2 HORIZONTAL TAIL 42.000 270.360 0.000 111.000
3 VERTICAL TAIL 23.000 276.930 0.000 137.760
4 MAIN GEAR WHEEL 45.000 97.000 0.000 69.000
5 MAIN GEAR STRUT 110.000 97.000 0.000 78.000
6 NOSE GEAR WHEEL 9.000 1.000 0.000 52.000
7 NOSE GEAR STRUT 40.000 1.000 0.000 65.000
8 FLIGHT CONTROL 57.000 123.000 0.000 105.000
9 NACELLE 62.000 21.000 0.000 92.000
10 ENGINE INSTALL 505.000 22.000 0.000 92.000
11 PROPELLER 74.000 -10.000 0.000 100.000
12 SYSTEMS 88.000 60.000 0.000 100.000
13 FURINSHINGS 175.000 105.000 0.000 100.000
14 UNUSABLE FUEL 12.000 73.000 0.000 80.000
15 FUSELAGE STRUC 250.000 99.000 0.000 80.000
———————————————————————————— END OF EMPTY WEIGHT ITEMS--—-—-—-—-—-—-----—-—-———————
51 PILOT 170.000 75.000 0.000 100.000
52 30 MIN FUEL 71.000 70.000 0.000 82.000
———————————————————————————— END OF MINIMUM WEIGHT ITEMS--------------—-—--—
61 COPILOT 170.000 75.000 0.000 100.000
62 3RD PERSON 170.000 111.000 0.000 100.000
63 4TH PERSON 170.000 111.000 0.000 100.000
64 5TH PERSON 170.000 150.000 0.000 100.000
65 6TH PERSON 170.000 150.000 0.000 100.000
66 BAGGAGE 120.000 180.000 0.000 110.000
67 FUEL TO FULL 409.000 70.000 0.000 87.000

———————————————————————————— END OF DISCRETIONARY WEIGHT ITEMS ------------

ENVELOPE OF DISCRETIONARY LOAD FOR 7

ADDED XBAR ZBAR WEIGHT
MINIMUM WEIGHT 73.092 90.725 2063.000
Fuel to Full 72.581 90.109 2472.000
Copilot 72.736 90.745 2642.000
4th Person 75.050 91.305 2812.000
3rd Person 77.099 91.800 2982.000
6th Person 81.031 92.243 3152.000
5th Person 84.560 92.639 3322.000
Baggage 87.888 93.245 3442.000
MINIMUM WEIGHT 73.092 90.725 2063.000
Baggage 78.969 91.784 2183.000
5th Person 84.101 92.378 2353.000
6th Person 88.541 92.892 2523.000
3rd Person 89.959 93.340 2693.000
4th Person 91.208 93.736 2863.000
Copilot 90.300 94.087 3033.000
Fuel to Full 87.888 93.245 3442.000
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Appendix A Input/Output Data for a 6 Place General Aviation Airplane

A.4 Wing Geometry

AERODYNAMIC SURFACE GEOMETRIC PROPERTIES

WING GEOMETRY
SYMMETRICAL ABOUT CL

COORDINATES OF LEADING EDGE
POINT NO FUS STA (XLE) WING STA (YLE)

1 45.000 0.000
2 64.313 46.500
3 72.000 201.000

COORDINATES OF TRAILING EDGE

POINT NO FUS STA (XTE) WING STA (YTE)
1 146.000 0.000
2 116.000 201.000

THE SURFACE IS DIVIDED INTO 20 INCREMENTS OF DY

AREA/SIDE MAC YLE (MAC) XLE (MAC) ASPECT RATIO
13256.722 69.246 87.854 63.641 6.095

ELEMENT DATA

ELEM XLE XTE Y C AREA
1 47.087 145.250 5.025 98.163 986.538
2 51.261 143.750 15.075 92.489 929.513
3 55.435 142.250 25.125 86.815 872.488
4 59.609 140.750 35.175 81.141 815.463
5 63.783 139.250 45.225 75.467 758.439
6 64.750 137.750 55.275 73.000 733.654
7 65.250 136.250 65.325 71.000 713.554
8 65.750 134.750 75.375 69.000 693.453
9 66.250 133.250 85.425 67.000 673.353

10 66.750 131.750 95.475 65.000 653.253
11 67.250 130.250 105.525 63.000 633.153
12 67.750 128.750 115.575 61.000 613.052
13 68.250 127.250 125.625 59.000 592.952
14 68.750 125.750 135.675 57.000 572.852
15 69.250 124.250 145.725 55.000 552.752
16 69.750 122.750 155.775 53.000 532.651
17 70.250 121.250 165.825 51.000 512.551
18 70.750 119.750 175.875 49.000 492.451
19 71.250 118.250 185.925 47.000 472.350
20 71.750 116.750 195.975 45.000 452.250
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Appendix A Input/Output Data for a 6 Place General Aviation Airplane

YT-hxi=s
zol.00 |
160.80 |
120.60 |
s0.40 |
40,20 |
o.00 T T T T T
: 45.00 85.40 125.80

£5.Z0 105,60 146.00
WING GEOMETEY H-Axis
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Appendix A Input/Output Data for a 6 Place General Aviation Airplane

A.5 Aileron Geometry

AERODYNAMIC SURFACE GEOMETRIC PROPERTIES

AILERON GEOMETRY
NOT SYM ABOUT CL

COORDINATES OF LEADING EDGE

POINT NO FUS STA (XLE) WING STA (YLE)
1 116.380 109.000
2 107.744 190.000

COORDINATES OF TRAILING EDGE

POINT NO FUS STA (XTE) WING STA (YTE)
1 116.380 109.000
2 129.522 110.401
3 117.642 190.000

THE SURFACE IS DIVIDED INTO 20 INCREMENTS OF DY

AREA/SIDE MAC YLE (MAC) XLE (MAC) ASPECT RATIO
941.589 11.710 147.500 112.275 6.968

ELEMENT DATA

ELEM XLE XTE Y C AREA
1 116.164 129.429 111.025 13.265 53.722
2 115.732 128.824 115.075 13.092 53.023
3 115.301 128.220 119.125 12.920 52.324
4 114.869 127.616 123.175 12.747 51.625
5 114.437 127.011 127.225 12.574 50.926
6 114.005 126.407 131.275 12.402 50.226
7 113.573 125.802 135.325 12.229 49.527
8 113.142 125.198 139.375 12.056 48.828
9 112.710 124.593 143.425 11.884 48.128

10 112.278 123.989 147.475 11.711 47.429
11 111.846 123.384 151.525 11.538 46.730
12 111.414 122.780 155.575 11.366 46.031
13 110.983 122.175 159.625 11.193 45.331
14 110.551 121.571 163.675 11.020 44.632
15 110.119 120.967 167.725 10.848 43.933
16 109.687 120.362 171.775 10.675 43.233
17 109.255 119.758 175.825 10.502 42.534
18 108.824 119.153 179.875 10.330 41.835
19 108.392 118.549 183.925 10.157 41.136
20 107.960 117.944 187.975 9.984 40.436
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Appendix A Input/Output Data for a 6 Place General Aviation Airplane

T-hxis

13000

173.80 |

157.60 |

14140 |

12520 |

T T T T T
109.00 197,74 116.46  125.17

11z._10 1z0.81 19 &2
AILERON GEOMETEY H-Axis
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Appendix A Input/Output Data for a 6 Place General Aviation Airplane

A.6 Aileron Forward of Hinge Line Geometry

AERODYNAMIC SURFACE GEOMETRIC PROPERTIES

AILERON FORWARD OF HINGE GEOMETRY
NOT SYM ABOUT CL

COORDINATES OF LEADING EDGE

POINT NO FUS STA (XLE) WING STA (YLE)
1 116.380 109.000
2 107.744 190.000

COORDINATES OF TRAILING EDGE

POINT NO FUS STA (XTE) WING STA (YTE)
1 116.380 109.000
2 118.993 109.279
3 109.705 190.000

THE SURFACE IS DIVIDED INTO 20 INCREMENTS OF DY

AREA/SIDE MAC YLE (MAC) XLE (MAC) ASPECT RATIO
186.547 2.320 147.500 112.275 35.171

ELEMENT DATA

ELEM XLE XTE Y C AREA
1 116.164 118.792 111.025 2.628 10.643
2 115.732 118.326 115.075 2.594 10.505
3 115.301 117.860 119.125 2.560 10.366
4 114.869 117.394 123.175 2.525 10.228
5 114.437 116.928 127.225 2.491 10.089
6 114.005 116.462 131.275 2.457 9.951
7 113.573 115.996 135.325 2.423 9.812
8 113.142 115.530 139.375 2.389 9.674
9 112.710 115.064 143.425 2.354 9.535

10 112.278 114.598 147.475 2.320 9.397
11 111.846 114.132 151.525 2.286 9.258
12 111.414 113.666 155.575 2.252 9.119
13 110.983 113.200 159.625 2.218 8.981
14 110.551 112.734 163.675 2.183 8.842
15 110.119 112.268 167.725 2.149 8.704
16 109.687 111.802 171.775 2.115 8.565
17 109.255 111.336 175.825 2.081 8.427
18 108.824 110.870 179.875 2.047 8.288
19 108.392 110.404 183.925 2.012 8.150
20 107.960 109.938 187.975 1.978 8.011
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Appendix A Input/Output Data for a 6 Place General Aviation Airplane

T-hxis

13000

173.80 |

157.60 |

14140 |

12520 |

T T T T T
109.00 g7 7wz, zu1e. 74
103.9814. 481899
LILERON FORVARD GEOMETEY K-Axis
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Appendix A Input/Output Data for a 6 Place General Aviation Airplane

A.7 Aileron Aft of Hinge Line Geometry

AERODYNAMIC SURFACE GEOMETRIC PROPERTIES

AILERON AFT OF HINGE GEOMETRY
NOT SYM ABOUT CL

COORDINATES OF LEADING EDGE

POINT NO FUS STA (XLE) WING STA (YLE)
1 118.993 109.279
2 109.705 190.000

COORDINATES OF TRAILING EDGE

POINT NO FUS STA (XTE) WING STA (YTE)
1 118.993 109.279
2 129.522 110.401
3 117.642 190.000

THE SURFACE IS DIVIDED INTO 20 INCREMENTS OF DY

AREA/SIDE MAC YLE (MAC) XLE (MAC) ASPECT RATIO
752.056 9.385 147.652 114.578 8.664

ELEMENT DATA

ELEM XLE XTE Y C AREA
1 118.761 129.388 111.297 10.627 42.893
2 118.296 128.786 115.333 10.489 42.336
3 117.832 128.184 119.369 10.352 41.779
4 117.368 127.581 123.405 10.214 41.222
5 116.903 126.979 127.441 10.076 40.666
6 116.439 126.376 131.477 9.938 40.109
7 115.974 125.774 135.513 9.800 39.552
8 115.510 125.172 139.549 9.662 38.995
9 115.046 124.569 143.585 9.524 38.438

10 114.581 123.967 147.621 9.386 37.881
11 114.117 123.365 151.658 9.248 37.324
12 113.652 122.762 155.694 9.110 36.767
13 113.188 122.160 159.730 8.972 36.211
14 112.724 121.557 163.766 8.834 35.654
15 112.259 120.955 167.802 8.696 35.097
16 111.795 120.353 171.838 8.558 34.540
17 111.330 119.750 175.874 8.420 33.983
18 110.866 119.148 179.910 8.282 33.426
19 110.402 118.546 183.946 8.144 32.869
20 109.937 117.943 187.982 8.006 32.313
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Appendix A Input/Output Data for a 6 Place General Aviation Airplane

T-hxis

13000

173.868 |

157.71 |

141.57 |

12542 |

T T T T T
109-2% 1ps 71 117.83 12558

112_67 lzl.&0 129 5E
AILERON AFT GEOMETEY H-Axis
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Appendix A Input/Output Data for a 6 Place General Aviation Airplane

A.8 Flap Geometry

AERODYNAMIC SURFACE GEOMETRIC PROPERTIES

FLAP GEOMETRY
NOT SYM ABOUT CL

COORDINATES OF LEADING EDGE

POINT NO FUS STA (XLE) WING STA (YLE)
1 122.567 23.000
2 114.065 108.753
3 129.522 110.401

COORDINATES OF TRAILING EDGE

POINT NO FUS STA (XTE) WING STA (YTE)
1 142.567 23.000
2 129.522 110.401

THE SURFACE IS DIVIDED INTO 20 INCREMENTS OF DY

AREA/SIDE MAC YLE (MAC) XLE (MAC) ASPECT RATIO
1556.629 17.900 64.914 118.411 4.907

ELEMENT DATA

ELEM XLE XTE Y C AREA
1 122.350 142.241 25.185 19.891 86.922
2 121.917 141.589 29.555 19.672 85.965
3 121.484 140.936 33.925 19.453 85.009
4 121.051 140.284 38.295 19.234 84.051
5 120.617 139.632 42.665 19.015 83.095
6 120.184 138.980 47.035 18.796 82.138
7 119.751 138.327 51.405 18.577 81.181
8 119.318 137.675 55.775 18.358 80.224
9 118.884 137.023 60.145 18.139 79.267

10 118.451 136.371 64.515 17.920 78.310
11 118.018 135.718 68.886 17.701 77.353
12 117.584 135.066 73.256 17.482 76.396
13 117.151 134.414 77.626 17.263 75.439
14 116.718 133.762 81.996 17.044 74.482
15 116.285 133.109 86.366 16.825 73.525
16 115.851 132.457